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SeaSonde Product Overview

System Description

The SeaSonde® is a simplified, compact oceanographic Doppler radar system for use in coastal
ocean observing systems. A network of two or more units, physically separated by tens of
kilometers along the coast, can combine data to produce two-dimensional surface current maps.
In some situations, measurements of wind direction, ocean surface waves and tsunamis can be
made as well. The surface current maps are the primary data product and are used by ocean
scientists for a variety of research topics and by organizations like the National Oceanic and
Atmospheric Administration (NOAA) and the US Coast Guard (USCG) for applications such as
Search & Rescue and Spill Response.

Near real-time surface current data for the U.S. can be accessed at:

https://hfradar.ndbc.noaa.gov

Introductory videos on oceanographic radar applications can be found at the following URLSs:
Search and Rescue: https://youtu.be/9A9LXT2cHZM

Spill Response: https://youtu.be/li83o0b2cwhE

The SeaSonde transmits a linear FM pulsed chirp with a duty cycle of 50% or less over tens to
hundreds of kHz, depending on the licensed bandwidth, with a center frequency in the HF or
lower VHF frequency bands, between 4 & 50 MHz. Typically, SeaSondes are licensed to sweep
over a frequency range that corresponds with all or part of one of the ITU Bands listed above,
with radiated power up to 80 Watts peak and 40 Watts average. Patented high precision
GPS-assisted sweep timing allows multiple SeaSondes to transmit simultaneously within the
same frequency range without interference to each other and without data acquisition
interruption.

Frequency Allocation

Frequency bands defined by the International Telecommunications Union (ITU) for use by
oceanographic radars are listed below.


https://hfradar.ndbc.noaa.gov
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ITU Ocean Radar Frequency Bands (MHz)

4.438 - 4.488 26.200 - 26.350°
5.250 - 5.275 26.200 - 26.420°
9.305 - 9.355° 39.000 - 39.500°

13.450 - 13.550

41.015 - 41.665°

16.100 - 16.200

42.000 - 42.500°

24.450 - 24.600°

43.350 - 44.000°

24 .450 - 24.650°

a — Regions 1 & 3 only b — Region 2 only

¢ — U.S. and South Korea only d — Region 1 only
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System Selection Considerations

Step 1: First choose a specific operating frequency
between 4-50 MHz and find applicable column (at right)
the selected frequency falls inside. Then select from
the configurations options below.

Frequency Band (MHz) Select applicable

column below

“Std”: option already included as part of standard configuration >20-50 11-20 4-<11
“N/C”: option available at no extra charge
“Opt. Add-On”: option available for a fee in addition to the base
price
Grey boxes indicate option not available.
} Configuration Options §
Power Supply 110 V (AC) Std Std Std
(select one)
220V (AC) N/C N/C N/C
24V (DC) Opt. Add-On | Opt. Add-On | Opt. Add-On
Low Power Transceiver | Opt. Add-On | Opt. Add-On Opt. Add-On
(only available <27
MHz)
Frequency Modulation Multiplexing (SHARE) Opt. Add-On | Std Std
(single-use license)
AutoAPM Kit (single-use license) Opt. Add-On | Opt. Add-On | Opt. Add-On
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Multi-Static Data Processing Software Package Opt. Add-On | Opt. Add-On Opt. Add-On
(single-use license)
Tsunami Detection Software Package (single-use Opt. Add-On | Opt. Add-On | Opt. Add-On
license)
Vessel (Ship) Detection Software Package (single-use Opt. Add-On | Opt. Add-On | Opt. Add-On
license)
Chassis & Tx & Rx Single Transmit N/C Std Std
Antenna Antennas | Antenna
Configuration(sel | Separate
ect one)

Twin Transmit Opt. Add-On Opt. Add-On

Antennas

Dual-Transmitter w/ Opt. Add-On

Twin Tx Antennas (not

presently optional w/Low

Power Transceiver)

Tx & Rx Antennas Combined Std Opt. Add-On Opt. Add-On

Extended Lightning Protection Kit Opt. Add-On | Opt. Add-On | Opt. Add-On
Antenna Base Hinge Assembly Opt. Add-On | Opt. Add-On Opt. Add-On

(compatible only with dome-style antennas & 5 MHz TX
antennas)
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Dome Antenna Guy Rope Holder (rope included) Opt. Add-On | Opt. Add-On | Opt. Add-On
Dome Antenna Guy Rope Holder (rope NOT included) Opt. Add-On | Opt. Add-On | Opt. Add-On
Tx/Rx Cable 1 X RG-8 75 meters Std N/C N/C
2 X RG-58

Combine Tx/Rx
AntennaOnly (select
one) price per meter (beyond | Opt. Add-On | Opt. Add-On | Opt.

75m) Add-On
Rx Cable 4 X RG-58 | 100 meters N/C Std Std
Separate Antennas
Only

custom length >100m Opt. Add-On | Opt. Add-On Opt. Add-On
(select one)

3 X RG-8 100 meters Opt. Add-On | Opt. Add-On Opt. Add-On

custom length >100m Opt. Add-On | Opt. Add-On Opt. Add-On
Tx Cable 1 X RG-8 75 meters N/C Std Std
Separate Antennas
Only (select one)

custom length >75m Opt. Add-On | Opt. Add-On Opt. Add-On
Smart Uninterruptable Power Supply (UPS) Opt. Add-On | Opt. Add-On | Opt. Add-On

11
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External Hard Drive Opt. Add-On | Opt. Add-On Opt. Add-On
Electronics Enclsoure (ENC36) Opt. Add-On | Opt. Add-On Opt. Add-On
Electronics Rack Opt. Add-On | Opt. Add-On Opt. Add-On
BackUp Battery Bank Opt. Add-On | Opt. Add-On Opt. Add-On
UPS Power Conditioning Unit with Battery Array and Opt. Add-On | Opt. Add-On | Opt. Add-On
Rack

24 V(DC) to AC converter (choose oneo f either 110V or | Opt. Add-On | Opt. Add-On Opt. Add-On
220V)

Mfr. Limited Warranty Extension (extending warranty Opt. Add-On | Opt. Add-On | Opt.
beyond first year) Add-On
Technical Support Service Contract (enquire on the Opt. Add-On | Opt. Add-On Opt. Add-On

variety available)

Site Planning

Antennas & Cables

The following are requirements for siting SeaSonde antennas to operate at maximum performance. It is not always
possible to meet the requirements listed below. For example, a site may not be as close to the water as possible in
order to avoid objects between the antenna and the water. Advanced planning and site scouting greatly benefit

antenna siting. A temporary setup is ALWAYS recommended in order to evaluate the SeaSonde’s performance at any

given location.
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Summary of planning tasks for siting antennas

Plan antenna location with respect to receive antenna and other vertical structures.

Plan cable routes between SeaSonde transmitter and transmit antenna making sure that the cable is long
enough to reach at both ends.

Plan antenna support.

Plan to protect against animal damage.

Plan to protect area around antenna against tampering and vandalism.

Distance Between Antennas

The following distances are the minimum allowable between SeaSonde transmit and receive antennas. (Not
applicable to combined transmit/receive antennas.)

SeaSonde frequency Min Antenna Separation
4.3-9.5 MHz 60 meters
11.5-17.0 MHz 25 meters
24.0-27.0 MHz 12 meters
39.0-44.0 MHz 6 meters

Distance to Water

e Locate antennas as close to the water’s edge as possible. The following distances are the maximum
allowable between a SeaSonde antenna and water:

SeaSonde Frequency Max Distance to Water
4.3-9.5 MHz 250 meters
11.5-17.0 MHz 150 meters
24.0-27.0 MHz 150 meters
39.0-44.0 MHz 100 meters
Terrain

e Antennas should be located on flat or gently sloping land.
e Avoid locating antennas directly in front of steep hills or cliffs.

Note: Locating antennas on top of a hill or cliff is acceptable as long as the steep section is below the antennas.

e Avoid terrain that rises between the antenna and the water, like rocks, points or cliffs.

13
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Objects Near Antennas

The following "clear area" should be maintained. Distances are minimums. The farther away any electrically
conductive object is from an antenna, the better.

e Ensure that above-ground objects are at least five times their height from the antenna location. The taller the
object, the farther away it must be.

Note:

For example, a six-meter-tall light pole should be at least

6 * 5 = 30 meters away from an antenna.

Electrically conductive objects (metal poles, wires, etc.) affect performance more than non-conductive.

e Ensure that no electric power lines or transformers are within 100 meters of antennas. Avoid high power
electric lines. Electric power lines cause radio interference.

Underground Objects

SeaSonde performance is adversely affected by nearby underground electrical conductors, such as metal pipes,
steel reinforcement bars or cables.

e Ensure that there are no long (any length greater than one meter) underground electrical conductors within a
100-meter-radius and 10-meter-deep area below the antenna base.

e Ensure that there are no shorter (any length less than one meter) underground electrical conductors within a
four-meter radius below the antenna base.

Note: Underground non-conductors do not affect SeaSonde performance.

Objects Between Antennas and Water

e Avoid objects that rise between the antenna and the water, like buildings or metal fences.

Objects That Affect Antenna Performance

The following is a list of common objects that affect antenna performance. These kinds of objects should be kept
outside the clear areas defined above.

Above-ground objects:

metal railings or fences*

buildings

rocks

cliff or steep slope BEHIND antennas
non-SeaSonde antennas

towers

overhead cables

large metal objects

trees

electric power lines, especially high voltage

Note: Mounting antennas on top of metal fences or light poles can help to mitigate the effects of these objects if there
is not sufficient clearance.
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Below-ground objects:

e metal pipes
e cables
e steel reinforcement bars

Radio Transmitters

e Avoid any non-SeaSonde transmitters operating in the area, including commercial navigation radars.
Radio Interference Environment
Please contact CODAR customer support at support@codar.com for additional information.

Antenna Support
e Plan how to support the antenna.

Antenna support depends on the characteristics of the site. If the site’s soil can be excavated, it is common to use a
reinforced-concrete in-ground pier. Plans for such a pier are included in this guide. A drawing of the antenna feed is
also included and shows the mounting bolt hole pattern. For temporary or short-term installations, the antenna can be
bolted to a sturdy plywood base (not supplied), which sits on the ground, and stabilized with guy ropes. The base
should be 0.75—-1 meters in diameter or square, with four holes drilled in the center and matching the antenna feed
bolt hole pattern. A hinged base-plate at the base of the mast is highly recommended for convenience of installation
and maintenance.

e Decide whether guy ropes will be needed.

If the support is very stable (for example, a concrete pier), guy ropes are not needed. Guy ropes should be made of
non-conductive material. Do not use metal guy wire or cable. For long-term installations, Kevlar rope with
UV-resistant outer braid is recommended. To reduce cost, nylon can be used for short-term installations. If guy ropes
are needed, plan how they will be anchored. Simple or cork screw stakes are commonly used. Metal stakes can be
used. Determine the required length. Guy ropes and stakes are not provided with the transmit antenna and must be
procured separately.

Cable Protection

Animals (rodents in particular) can gnaw through cables. Plan to avoid this potential damage. Covering the cable with
plastic split loom tubing (1 inch nominal size) is an inexpensive way to protect the cable. Running the cable through
conduit is also an option. Conduit can be buried. Schedule 40 PVC pipe can be used as conduit.

Security and Safety

People should not touch the antenna or risk tripping over the wires on the ground that radiate in a circle from the base
of the antenna. Use a non-metallic fence, markers and/or signage, especially if the site is accessible to the public.To
comply with RF exposure requirements the antenna must be installed to provide a minimum separation distance from
persons as shown in the table below based on the operating frequency of the system:
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Operating Frequency Minimum
(MHz) Separation
Distance (m)

4.48 10.66
5.25

13.45 3.55
16.10

24.45 2.30
26.20

41.00 2.60
43.35

Electronics Housing

Dimensions

SeaSonde electronics consist of one each of a transmit and receive chassis. Both are rack-mountable and designed
to fit industry standard 19 inch (48 cm) wide racks. Each chassis is 3U (13.335 cm) tall and requires a depth of 56
cm including space for cable connections.

A SeaSonde also comes with a computer, keyboard, mouse and monitor. Space needs to be provided for these
items. Unless specified otherwise, a Mac Mini computer is provided: (5.08H x 16.51W x 16.51D cm). Typically, a 17"
monitor is provided but needs only be connected during user interaction.

Additional room in the rack should be budgeted for the recommended UPS and extra battery banks or other
peripherals. When installed, the transmitter and receiver chassis should be positioned such that an operator can
easily disconnect it from the power source.

Climate Control

Depending on the transmit power, the SeaSonde will generate approximately 1000 BTU per hour. This heat needs
to be dissipated or displaced as well as any additional heat from other peripherals (DSL /cable modems, etc.) or
external sources, such as the ambient air or solar radiation. Ambient air temperature inside the electronics enclosure
should be kept at / below 95° F (35° C) if possible. If ambient air temperature is consistently higher, the performance
and life of your system may be degraded and manufacturer’s warranty will be voided.

16
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Also, a closed system should be used to isolate SeaSonde electronics from the salt air found near the coast.
Additionally, if air conditioning is installed on the electronics rack within an exterior housing, be sure to vent warm air
exhaust outside or into a room with climate control or volume of sufficient size to prevent overheating.

Power

SeaSondes are delivered with one of three possible input voltages: 240VAC, 120VAC or 24VDC. Be sure your
SeaSonde electronics match your power source’s voltage. Clean reliable power is a necessity for SeaSonde
operation. CODAR recommends using an Uninterruptible Power Supply in line with the computer and electronics.
This will protect against unstable power and brownouts. The AC SeaSonde’s power consumption is approximately
650 W continuous. Air conditioning and peripheral devices will add to this amount.

Communications

Robust communications are an essential part of maintaining a SeaSonde® network. A fast and reliable data
connection will allow you to transfer data files, browse the remote file system, run commands and view/control the
remote screen. This will reduce downtime by allowing the operator to diagnose and fix problems sooner or even
prevent problems before they affect data acquisition. When working with Radio Frequency (RF) signals, the ability to
view real-time spectral graphs is invaluable for diagnosing problems and identifying solutions. Lastly, it is the
responsible thing to do because most frequency-granting authorities require the ability to shutdown broadcast
equipment immediately, if necessary. As much as reliable power and good environmental controls, communications
should be considered and planned well ahead of SeaSonde installation.

With the above ideas in mind, remember the following guiding principles when choosing your SeaSonde’s
communications solution:

Data transfer should be robust with minimal dropouts or downtime

The upload bandwidth should be 256 kbit/s or greater for screen control

You should be able to find the SeaSonde computer on the internet and initiate an incoming connection at a
moment’s notice

The SeaSonde computer allows for data transfer to the SeaSonde combine server or any file server that the user
chooses. The best options for data transfer are SSH and Timbuktu Pro transfers, which are scheduled through Unix
cron commands. The following should be considered when planning and implementing a communications solution
for your SeaSonde remote unit.

Public IP Address

Internet Protocol (IP) addresses are the way devices find each other over the network. When making a decision
about which method to use for communications, make sure that the IP address assigned to your computer is not
private. Private IP addresses are reserved for devices behind routers that share a single public IP address using
network address translation (NAT). They will match one the following patterns:

192.168.x.x 10.X.X.X 172.16-31.x.x

If the SeaSonde Computer is assigned an IP address matching one of these patterns, then you will not be able to
access it remotely unless you are able to implement port forwarding. Traffic on port 22 (SSH) and/or port 407
(Timbuktu Pro®) that arrives at the public address is forwarded to the SeaSonde computer’s private address. Not all
ISPs are willing or able to provide this service.

17
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Static IP Address

In addition to having a public IP address, it is also important to have a static IP address that you can always rely upon
to contact your SeaSonde remote unit computer. A static IP address is one that will only be assigned to your
computer and will not change, even when the computer is rebooted or reconnects to the internet. If you cannot get a
static IP address, use one of these solutions:

Dynamic DNS Service

Domain Name System (DNS) matches name internet addresses like codar.com to numeric addresses like
72.41.175.235. Dynamic DNS service allows you to choose a nhame address like mysitename.dyndns.com and then
dynamically match it to your computer’s numeric address, even if that numeric address changes. Software runs on
the remote computer to keep the match up to date. There are several of these services available online that support
Mac OS X. The ones most often used by CODAR customers are www.dyndns.com and www.noip.com. Typically,
you sign up for an account using your email address. For each account/email address, you may get 1-5 dynamic
name IP addresses for free. You can get more per account/email address with a monthly fee. There is rarely more
than a 30 minute lag between the IP address being updated and the match being updated. All TCP/IP protocols can
use Dynamic DNS.

Timbuktu IP Locator

Timbuktu (included on every radial SeaSonde computer) has a feature similar to dynamic DNS service whereby you
supply your email address to the Timbuktu software on the SeaSonde computer and it reports the public ip with your
email address to a Netopia server. The service is included with the software license and does not interfere with
dynamic DNS services but you can only use each email address once per computer and it only works with the
Timbuktu remote control and file transfer software (no SSH, rsync, FTP, etc.). This is a great secondary method in
case dynamic DNS fails.

Push Data

If your remote unit computers do not have static IP addresses and the combine site has a fixed, public IP address,
then the preferred solution is to set up your remote machines to "push" data back to the central site. This has the
advantage that the remote machine IP address can change without interrupting data collection. This can be done in
addition to all of the above methods. The disadvantage is that you have to dig through log files to find out the current
IP addresses of the radial site computers.

Firewalls

If your ISP has a firewall in place, be sure to have them open at least the following ports to the SeaSonde computer:

Protocol Port

Secure SHell (SSH) 22

Timbuktu Pro 407

Apple Remote Desktop 3283, 5900
RadialWebServer 8240 (can be changed)

18
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Assembling the Antennas

Inventory and Preparations

If the installation site is remote, a missing part or tool will delay the installation. Ensure that you have all the required
parts, tools and support equipment before departure. Checklists are provided in this guide.

Pack a clean work surface in your field kit. A piece of cardboard, paper, or cloth will work. The surface will be placed
under threaded antenna parts to keep them clean. In addition, many small parts are used to assemble the antenna.
The small parts are difficult to find if dropped in grass or dirt. A surface under the work area makes it easy to find
dropped items.

Include spare fasteners in your field kit, in case any are lost. Spare fasteners must be made of the material specified
in the checklists. In particular, do not replace stainless steel parts with non-stainless steel.

Inspection

Summary procedure:

e |nspect physical condition.
e  Perform electrical continuity checks.

A damaged or malfunctioning part will delay installation. The following inspections and tests should be performed
prior to departure to a remote installation site.

The transmit cable and corresponding connectors on the antenna and transmitter are Type N coaxial connectors.
Each connector has two conductors, a central pin or socket and an outer hollow cylinder. The conductors are
enclosed by a threaded metal body.

center pin

outer conductor

body

Type N Connector Plug

19
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center socket

outer conductor

body

Type N Connector Socket

Inspect the physical condition of all electrical connectors.

Connector bodies should not be bent or damaged.

Connectors should be securely attached to cables.

Connector pins, sockets and outer conductors should not be bent or loose.

Center pins and outer conductors should not extend beyond connector bodies.

Center pin should sit flat with the outer conductor. Should not be recessed in too much(not more than 1mm)
or extend beyond the outer conductor.

Perform electrical continuity checks with an ohmmeter or multimeter. Remember, zero or low resistance indicates
continuity, the ability to conduct electricity. Infinite or large resistance indicates no continuity. Some meters have a
continuity test mode.

Continuity checks for the spooled cable are performed easily while the cable is on the spool.

On the spooled transmit and receive cables, measure continuity between the connector center pins at the
two ends of the cable. There should be continuity (very low or zero resistance).

On the spooled transmit and receive cables, measure continuity between the connector outer conductors at
the two ends of the cable. There should be continuity.

On the spooled transmit and receive cables, measure the continuity between a connector center pin and the
outer conductor of the same connector. There should be no continuity (very high or infinite resistance).
Repeat for the antenna cable connector at the other end of the cable.

Transmit Antenna Check (Long Range only)

A lightning arrester with a Type N socket connector is mounted on the spool-shaped ground-plane feed
subassembly, attached to the lower antenna section. Measure the resistance between the center socket of
the connector and the lightning arrester housing. Be careful. Do not bend or damage the center socket when
measuring. There should be no continuity.

There is an exposed metal fitting on the lower antenna section, 0.75 meters above the base. Measure the
resistance between the center socket of the lightning arrester connector and the metal fitting. There should

20
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be continuity. (There is an epoxy seal opposite the metal fitting. Be careful. Do not remove or damage the
seal.)

Transmit Only Antennas

5 MHz Transmit Antenna

When assembled and raised, the long range transmit antenna is approximately 8.9 meters (29.2 feet) tall and weighs
approximately 45 kilograms (100 pounds). The antenna assembly consists of two long sections with a tuning coil
connecting them. A “top hat” adapter is mounted at the top of the antenna assembly. Eight ground plane wires, 7
meters long, are connected to the base and form a circle on the ground.
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Tuning Coil Jumper Strap

The tuning coil is shipped with a metal jumper strap installed. If you plan to transmit at a frequency greater than 4.6
MHz, leave the jumper strap installed. If you plan to transmit at a frequency less than or equal to 4.6 MHz, the

jumper strap should be removed.

jumper strap

tuning coil
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The tuning coil jumper strap is held in place by screws and star washers at its upper and lower ends. To remove the

jumper strap:

Loosen, but do not remove, the lower screw (nearest the socket end of the tuning coil).
Remove the upper retaining screw (nearest the exterior-threaded end of the tuning coil).
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Rotate the strap 180 degrees around the lower screw.

Replace and tighten the upper screw and star washer. Tighten enough so that the screw stays in place. Do

not over tighten.

Tighten the lower screw enough so the strap does not move. Do not over tighten.

Installation

A crew of at least three strong people is needed to raise the antenna.

Transport all the parts and tools to the installation site.

Installing Cable

Antenna Parts Checklist

Parts marked “not supplied” are not supplied by CODAR and must be procured from other sources.
Note: many parts are pre-assembled. For example, the antenna feed is completely assembled and mated to the

lower antenna section.

Check Qty Description

UPPER ANTENNA SECTION PARTS

1 transmit antenna, upper section

2 set screw, cup point, 10-32 x 3/8", 3/32" hex socket, stainless
steel
LOWER ANTENNA SECTION PARTS (The fasteners and
gasket listed mate the lower antenna section to the antenna
feed subassembly.)

1 transmit antenna, lower section

4 cap bolt (full thread), 1/2-13 x 2-3/4”, stainless steel

8 flat washer, 1/2”, stainless steel

4 lock washer, 1/2”, stainless steel

4 nut, 1/2-13, stainless steel

(optional), teflon gasket (Gasket goes between lower antenna
section and antenna feed.)
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ANTENNA FEED PARTS

spool-shaped base, stainless steel

ground plane wires, 25 feet long, stainless steel

bolt, 1/4-20 x 3/8”, stainless steel (fastens ground plane wire to
antenna feed)

lock washer, 1/4” (on ground plane wire bolt)

flat washer, 1/4” (on ground plane wire bolt)

antenna feed connector, Type N, attached to base

lightning arrester with Type N connector, attached to antenna
feed connector

TUNING COIL ASSEMBLY PARTS

tuning coil

tuning coil jumper strap, stainless steel, with black shrink tube
insulation

screw, phillips head, 10-32 x 1/4”, stainless steel

internal star washer, #10, stainless steel

set screw, cup point, 10-32 x 3/8", 3/32" hex socket, stainless
steel

TOP HAT ASSEMBLY PARTS

top hat adapter, stainless steel sleeve

antenna element, 0.062” diameter, 3 feet long, titanium alloy (6
AL/4V ELI)

retaining washer, 1” outside diameter, with five holes

cap screw, 8-32 x 7/16", 9/64" hex socket, stainless steel

internal star washer, #8
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3 set screw, cup point, 10-32 x 3/16", 3/32" hex socket, stainless
steel, red marking on threads (inserted in upper holes of top hat
adapter)

3 set screw, soft point (nylon), 10-32 x 3/16", 3/32" hex socket,
stainless steel, green tipped (inserted in lower holes of top hat
adapter)

MOUNTING HARDWARE (not supplied)

4 (not supplied) bolt, 5/8”-11, length as required

4 (not supplied) nut, 5/8”-11

4 (not supplied) lock washer, 5/8”

4 (not supplied) flat washer, 5/8”

4 (optional, not supplied) guy ropes, non-conductive, length as
required (10 m nominal). For long-term installations, Kevlar with
UV-resistant outer braid is recommended. To reduce cost, nylon
can be used for short-term installations.

4 (optional, not supplied) stakes or anchors to tie down guy ropes

1 (for temporary install, not supplied) base, plywood, 1-inch thick
(minimum), 0.75—-1 m diameter or square, holes drilled with
antenna feed bolt hole pattern
CABLE

1 cable, RG-8 with N-type connectors, 75 m
OPTIONAL EQUIPMENT

1 lightning protection kit, CODAR part LP-100

as (not supplied) non-metallic fencing, markers, and/or signage

required

as (not supplied) split loom tubing, plastic,1 inch nominal, or

. conduit, (e.g., Schedule 40 PVC), 1 inch nominal, (to protect
required [ caples from animal damage)

Tool Checklist (Tools not supplied.)
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Check Qty Description
1 hex (Allen) driver or key, 3/32"
1 hex (Allen) driver or key, 9/64"
1 strap wrench
as hammer(s) to drive ground plane wire stakes and guy rope
stakes
required
1 Ohmmeter or multimeter for continuity checks
1 tape measure or rangefinder
as Moisture-proof insulating silicone lubricant. Dow Corning 4
Electrical Insulating Compound is recommended.
required
as clean working surface (cardboard, towel, etc.)
required
1 (optional) pipe, 1 m long, to put through cable spool
Summary:

e Locate antenna site.
e Unspool and route cable.

Exercise care when installing the cable. Do not crush the cable or allow it to kink. (Minimum bending radius is 4
inches.) Do not exert excessive pulling tension on the cable. (Maximum pulling tension is 230 pounds.) Do not pull on

the connectors. Do not damage the connectors.

e Find the desired transmit antenna location. Pace off the distance or measure with a rangefinder or tape.
Ensure that the cable length is adequate for the distance between the SeaSonde electronics and antenna.
e Start at the SeaSonde electronics and ensure the transmit cable can be mated to the transmitter (or optional

LP-100 lightning protection kit, if installed) and is properly routed.

e Unspool the transmit cable from the antenna site to the SeaSonde electronics. Insert a 1 meter pipe through
the spool and have two people walk the pipe and spool to the electronics. Excess cable should be stored

near the electronics, not near the antenna.

Double-check the routing and ensure there is enough slack to mate the connectors at each end.
If needed, install split loom tubing or other protection around the cable to avoid damage by animals.

Assembling Top Hat Adapter

The top hat adapter is so named because it fits over the top of the antenna. It consists of a metal sleeve and four stiff
wire elements. The wire elements are held in place by a washer-like retainer and four fasteners. The top hat adapter

is secured to the antenna with set screws.
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Summary:
e Flag the sharp ends of the wire elements with tape for safety.
e Loosen retaining washer screws.
e Insert wire elements.
e Tighten retaining washer screws.

Injury warning: the wire elements may cause injury to eyes or other parts of the body. Mark the end of each wire, so
that it is seen easily. Safety glasses are recommended.

Place a piece of adhesive tape on one end of each wire, so that it is seen easily.

Using a 9/64 inch hex (Allen) driver or key, loosen the four cap screws that hold the retaining washer in
place at the end of the top hat adapter. Loosen just enough to slip the wire elements snugly between the
retaining washer and one of the grooves in the top hat adapter.

Insert a wire element between the retaining washer and a groove in the top hat adapter. Repeat for all four
wire elements.

Tighten the four cap screws on the top hat adapter.

Set the top hat adapter aside. It will be installed on the antenna a few steps later.

Assembling Antenna

Summary:

Arrange antenna sections.

Lubricate with non-conductive silicone grease (Dow Corning DC-4 or equivalent) and screw upper antenna
sections and tuning coil together. Tighten set screws.

Lubricate and screw together lower antenna section and tuning coil. Tighten set screws.

Install guy rope collar and guy ropes if used.

Install top hat adapter.

Lay out the two antenna sections on the ground and arranged end-to-end for assembly. The tuning coil is
installed between the lower and upper antenna sections. Ensure that the connecting parts remain clean by
placing a clean surface (cardboard, paper, a towel or rag, etc.) under them.

Ensure that the tuning coil jumper strap is in the correct position. It should be installed (secured with both
screws) when transmitting greater than 4.6 MHz. It should be uninstalled (removed from the upper screw)
when transmitting less than or equal to 4.6 MHz. If the tuning coil jumper strap must be uninstalled, follow
the instructions earlier in this guide.

Coat the socket threads at the bottom of the upper antenna section with a moisture-proof insulating
lubricant. Dow Corning DC-4 Electrical Insulating Compound is recommended.

Coat the threads at the upper section of the tuning coil (Dow Corning DC-4 or equivalent works well).
Screw the tuning coil tightly onto the upper antenna section.

Tighten the two set screws at the bottom of the upper antenna section using a 3/32 inch hex (Allen) driver or
key.

Coat the socket threads of the tuning coil with moisture-proof (e.g. Dow Corning DC-4).

Coat the threads at the top of the lower antenna section with moisture-proof insulating lubricant.

Screw the tuning coil with upper antenna section tightly onto the lower antenna section. Use a strap wrench
if necessary.

Tighten the two set screws at the bottom of the tuning coil using a 3/32 inch hex (Allen) driver or key.

Wrap the metal sections of the tuning coil with electrical tape or self fusing tape for added protection.
(Optional.) If using guy ropes, slip the top of the antenna through the center hole of the guy rope collar. The
eye bolts on the guy rope collar should point downward, i.e., the eyes should be closest to the ground when
the antenna is raised. Slide the collar to the center of the antenna until it stops in place at the metal fitting of
the upper antenna section.
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(Optional.) If using guy ropes, attach four non-conductive guy ropes to the four guy-rope-collar eye-bolts.
Begin installing the top hat adapter by placing it over the top of the upper antenna section. Ensure that the
top of the antenna is completely inserted in the top hat adapter.

e Tighten the three upper top hat adapter set screws (cup point with red marking) using a 3/32-inch hex (Allen)
driver or key. These metal-tipped screws should make firm contact with the metal tip of the antenna whip.

e Tighten the three lower top hat adapter set screws (soft point, green-tipped) using a 3/32-inch hex (Allen)
driver or key. These nylon-tipped screws are designed to make contact with the fiberglass whip just below its
metal tip. Do not overtighten.

e Remove the adhesive tape markers from the top hat adapter wire elements.

Raising and Securing Antenna

Summary:

Orient antenna.

Raise antenna.

Place antenna on support and tighten fasteners.

Secure guy ropes if used.

Release and arrange ground plane wires. Stake if needed.

Mark keep-out area if needed.

e Take up cable slack.

e There are nine evenly spaced ground-plane wires connected to the ground-plane feed assembly in a 360

degree arc and secured to the feed with bolts.

If needed, attach a temporary base to the ground plane feed assembly base.

Hold the antenna base in position while others lift the antenna at its middle (near the tuning coil) and raise
the antenna by walking it toward the base.

e [f using a permanent support, lift the antenna and place the ground plane feed assembly over the support
bolts. Install and tighten support nuts. A hinged baseplate adapter is highly recommended as a safety
measure and ease of antenna maintenance in the future.

e [f using guy ropes, secure them while one or more people hold the antenna in place.
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e The ground plane wires are wrapped around and secured to the ground plane feed assembly. Remove the
material that secures the ground plane wires.
Unwrap the ground plane wires from the ground plane feed assembly.
Arrange the ground plane wires so that they are evenly spaced 360 degree around the antenna base.
If needed, secure the ends of the ground plane wires with long nails or irrigation hose stakes to keep them in
their proper orientation. Metal stakes can be used.

e |f needed, mark or secure the area with non-metallic fence, markers and/or signage to keep people from
tripping over the ground plane wires or touching the antenna.

e Take up any cable slack at the antenna by looping the cable into a 0.3 meter diameter coil at base of
antenna.
Connect the transmit cable to the lightning arrester at the base of the antenna.
Connect the transmit cable to the transmitter connector or the optional LP-100 lightning protection kit.

Drawings

Concrete Support Pier
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Antenna Feed
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9 MHz Transmit Antenna

The 9 MHz transmit antenna is a trimmed down version of the 5 MHz transmit antenna. There is no tuning coil and
top hat. The top whip is 8 feet long instead of 12 feet long. For installation, follow those for the 5 MHz transmit
antenna except for the 3 items mentioned above.

Dome Style Combine Antennas

5 MHz Combine Antenna

The design 5 MHz combine antenna consists of a monopole element and a cross loop. The monopole element is
omni-directional and is used both as a transmit antenna and a receive antenna. The cross-loop antennas have
sinusoidal patterns orthogonal to each other and are housed inside the dome.

When assembled and raised, the antenna is approximately 8 meters tall. The antenna consists of one antenna
element (a fiberglass whip), a dome-shaped base that contains electronics, a fiberglass mast, inner mast assembly,
the tuning element, the hinge and ground plane assembly and Transmit-Receive (TR) cable spool. (see Table and
Figures below).

Antenna Parts

Item # Ship

(refer to Antenna Parts Qty Model Number | Bund
images below) led
1 (TSRO ﬁ]':fgt';f‘e;\ssemb'y SSRA-101-05TR
2 Dome Assembly 1 SSRA-SA101-05
3 Inner Top Antenna Tube 1
4 Antenna Tube Joint 1
5 Hand hole cover 1 X
6 Sight Pins 2
7 Assembly Screws
8 Spare Screws
9 Tuning Element 1
10 Lower Antenna Tube 1
1 RG-316 cable assembly 1 X
12 Bottom guide plastic tube 1
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13 Antenna Whip 1

14 Antenna Mast (Dome-style) | 1 SSRA-SA301-13

15 Hinge Assembly 1

16 Ground Plane Assembly 1 X
17 Mounting Screws

18 TR Antenna Cable (75m) 1 TRCBL-STD S
19 J-bolts 4 S

ltems 2, 3 & 4 are shipped pre-assembled. Similarly items 10,11 & 12 are shipped pre-assembled. These upper and
lower antenna tubes are connected together and then secured to the outer fiberglass mast.

Lastly, the cable connectors at the base of the mast are attached to the mast strain relief fixture and cable connectors
are attached. The next few pages describe the assembly procedure in detail.

Tools List
e  Phillips screwdriver #2 size
e 2 Adjustable wrench or spanner wrench with 1 1/2” or 300 mm openning
e 7/16” fixed opening wrench, or 7/16” socket.
e Allen key - contact customer support for exact size for your antenna.

Procedure

Identify the upper and lower antenna tube assemblies.

A plastic tube with the RG-316 cable assembly is present inside the lower antenna tube as shown in the
above picture.

Pull out the plastic tube so that you can see the RG-316 cable assembly.

Align the upper and lower inner antenna tube assemblies. Packing foam could be used for convenience to
support the antenna tubes.

Connect the RG-316 cables to the respective TNC connectors on the antenna tube joint of the upper
antenna tube. Use silicon grease on TNC connectors and the portion of the antenna tube joint where the top
and bottom tubes make a connection (Dow Corning 4 Electrical Insulating Compound is recommended).
Cables are labelled as shown below. Hand tighten the connectors. Connectors #2 has reverse polarity so it
is not possible to connect them wrong.

Once both cables are connected, slide the bottom mast over the antenna tube joint so that the two tubes are
connected. Plan the clocking so that the bottom connector joint faces the hand hole after the antenna tube of
the dome assembly is installed inside the mast. Use 1/4-20 hex screws (as shown in the picture below) to
fix the lower tube to the joint.

This completes the assembly of the inner tube assemblies..

Locate the connectors at the bottom of the lower antenna tube (1 RP TNC and 2 TNC bulk-head jack
connectors) and ensure that they are still inside the protective bag. If not, use a protective wrap to avoid
damage.

Install guy rope holder if so equipped.
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Next, slide the entire inner assembly into the outer fiberglass mast. When the inner assembly hits a stop, go
to the Hand hole end, reach in to guide the bottom plastic tube through the centering rods.

Insert hardware screws in the fiberglass mast collar.

Align dome base with fiberglass mast collar screws. Tighten all collar screws to attach the dome base.
Attach antenna whip element to top of the dome. Use silicon grease to attach the whip.

There is a locknut at the base of the threads on top of the dome. Do not remove this lock nut. After attaching
the whip element, tighten this lock nut counter-clockwise against the nut on antenna whip. This prevents the
whip from unscrewing itself due to wind induced vibrations.

Install the top part of the hinge assembly to the bottom of the antenna mast with the 4 x %-13 screws. Use
flat washers on mating surfaces and lock washers on top. While installing the hinge plate, make sure the
cables and connectors are not jammed in the interface. Tighten the bolts and install jam nuts.

At the base of the fiberglass mast, pull bulkhead connectors down and out through the hole in the hinge top
plate..

Affix two TNC bulkhead connectors to the bottom connector panel. Make sure that channel 1 and 2 are
matched to the labels on the panel.

Connect the TNC RP connector to the TNC RP jack on the tuning element. Apply silicone grease to the
contacts before engaging. Hand tighten the connector.

Connect the channel 3 connector from the connector panel to the TNC jack of the tuning element. Apply
silicone greatest to the contacts before engaging. Hand tighten the connector.

Apply electrical tape to the connector for protection.

Stuff tuning element and loose cables into the mast. Use 4 knobed screws to fix the connector panel to the
bottom of the hinge plate. Use grease on the thread. Hand tighten the screws.

Install the ground plane assembly if not already installed.

Mate the top hinge plate with the bottom hinge plate and erect the mast.

Install 2 x ¥2-13 bolts to secure the hinge assembly.

Connect the N connector from ground plane assembly to the N jack on the connector panel.

Connect 3 connectors from TR cable with matching cable label or color code. Apply silicone grease before
engaging connectors. The color coding convention is: red - #1, blue - #2, while - #3. #1 and #2 connectors
connect to the connector panel. #3 connects to the lightning arrestor on the ground plane assembly

To complete assembly, connect the TR Cable Spool cable TNC & N connectors to connector jacks of this
cable set. Apply weather resistant tape (shipped with the choke cable) on all three connectors.

If using guy ropes, secure them while one or more people hold the antenna in place.

The ground plane wires are wrapped around and secured to the ground plane feed assembly. Remove the
material that secures the ground plane wires.

Unwrap the ground plane wires from the ground plane feed assembly.

Arrange the ground plane wires so that they are evenly spaced 360 degree around the antenna base.

If needed, secure the ends of the ground plane wires with long nails or irrigation hose stakes to keep them in
their proper orientation. Metal stakes can be used.

If needed, mark or secure the area with non-metallic fence, markers and/or signage to keep people from
tripping over the ground plane wires or touching the antenna.

13 MHz Combine Antenna

The procedure outlined below is the same for all dome style receive and T/R combined antennas. The photos were
taken for a 13 MHz combined antenna and so minor manufacturing differences may exist between your antenna and
those shown here. If you have any questions, please contact CODAR support. Use the instructional video located on
the Support website along with the instructions below for the dome antenna set-up.

When assembled and raised, the antenna is approximately 8 meters tall. The antenna consists of one antenna
element (a fiberglass whip), a dome-shaped base that contains electronics, a fiberglass mast, inner mast assembly
and Transmit-Receive (TR) cable spool. (see Table and Figures below).

Dome Style Combine Antenna Parts
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Item # Ship
(refer to Antenna Parts Qty | Model Number
images below) Bundled
1 TR Antenna Assembly SSRA-101-13T
(Dome-Style) R
2 Dome Assembly 1 ESRA-SM 01-1
3 Inner Top Mast 1
4 Antenna Tube Joint 1
5 Hand hole cover 1 X
6 Sight Pins 2
7 Assembly Screws
8 Spare Screws
9 Inner Bottom Mast 1
10 RG-316 cable assembly 1
11 Bottom guide plastic tube 1 X
12 Antenna Whip 1
13 Antenna Mast (Dome-style) | 1 §SRA-SA3O1-1
16 TR Antenna Cable (75m) 1 TRCBL-STD X

ltems 2, 3 & 4 are shipped pre-assembled. Similarly items 11,12 & 13 are shipped pre-assembled. These top and
bottom inner masts are connected together and then secured to the outer fiberglass mast.

Lastly, the cable connectors at the base of the mast are attached to the mast strain relief fixture and cable connectors
are attached. The next few pages describe the assembly procedure in detail.

Tools List

e  Phillips screwdriver #2 size
e  Adjustable wrench with 1 1/2” or 300 mm openning
e 7/16” fixed opening wrench, or 7/16” socket.

Procedure

Identify the top and bottom inner mast assemblies.
A plastic tube with the RG-316 cable assembly is present inside the bottom inner mast as shown in the
above picture.

e  Pull out the plastic tube so that you can see the RG-316 cable assembly.
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e Anplastic tube with the RG-316 cable assembly is present inside the bottom inner mast as shown in the
above picture.

e  Pull out the plastic tube so that you can see the RG-316 cable assembly.

e Align the top and bottom inner mast assemblies using the mast stands.

e Connect the RG-316 cables to the respective SMA connectors on the dipole feed assembly of the inner top
mast. Use silicon grease on SMA connectors and the polycarbon coupler portion of the Dipole Feed
Assembly where the top and bottom inner masts make a connection (Dow Corning 4 Electrical Insulating
Compound is recommended). Cables are labelled as shown below. Optimal tightening of the SMA

connectors is 8 inch-Ibs, or ~ 1 N-m. This can be done with a torque wrench, or by hand tightening and
adding an extra 30 degrees turn.
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Cable Labels

e  Once all the 3 cables are connected, slide the bottom mast over the polycarbon coupler so that the two

masts are connected. Use 8-32 Phillips head screw with spring washer for feed connection (the brass

terminals) and 1/4-20 hex screw (as shown in the picture below) for mechanical attachment to the
polycarbon support.

e This completes the assembly of the inner masts.

e Locate the bottom guide plastic tube at the end of the bottom mast. 3 RG-316 cables with 1 N and 2 TNC
bulk-head jack connectors exit through the bottom guide.
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Have bulkhead connectors tacked into the plastic tube to avoid breaking them while sliding into the outer

mast.
Next, slide the entire inner assembly into the outer fiberglass mast. When the inner assembly hits a stop, go

to the Hand hole end, reach in to guide the bottom plastic tube through the centering rods.

Insert hardware screws in the fiberglass mast collar.

Align dome base with fiberglass mast collar screws. Tighten all collar screws to attach the dome base.
Attach antenna whip element to top of the dome. Use silicon grease to attach the whip.

There is a locknut at the base of the threads on top of the dome. Do not remove this lock nut. After attaching
the whip element, tighten this lock nut counter-clockwise against the metal antenna whip fitting. This
prevents the whip from unscrewing itself due to wind induced vibrations.
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At the base of the fiberglass mast, pull bulkhead connectors down and out through the access port.

Find strain relief flap on back interior of mast.

Connect all three bulkhead connectors to cable strain relief. Secure the connectors with the nuts provided
along with the connectors.

Locate the 22 feet cable bundle with ferrites (13 MHz only). There are 3 cables in this bundle with cables for
the two loops each and the dipole.

Lay out the cables on the ground. One end of the cables has 2 TNC and 1 N plug connectors. The other end
has bulkhead connectors. There are ferrites on each end of each cable. Place the ferrites gently on the
ground do not drop them. Ferrites can crack or break easily which will compromise performance.

Bulkhead
Connectors

Feed the plug connectors into the bottom of the fiber glass mast or the side hole.

Connect 3 connectors with matching cable label or color code. Apply silicone grease before engaging
connectors. The color coding convention is: red - #1, blue - #2, while - #3.

To complete assembly, connect the TR Cable Spool cable TNC & N connectors to connector jacks of this
cable set. Apply weather resistant tape (shipped with the choke cable) on all three connectors.
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Antenna sighting method

Dome antenna is shipped with sight pin screws.

e These are index markers for sighting the bearing of the black arrow. Two of the fasteners on the bottom
plate of the Dome antenna, which are parallel to black arrow, are standoffs into which the sight pins can be
inserted.

e |n certain sites, it would not be practical for the user to stand back in the direction of the black arrow due to
landscape limitations. The user may desire to change the standoff to other orientations and make the
corresponding changes for the bearing measurement.

e After attaching guy ropes (if required), erect the antenna and secure via permanent antenna mount.
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e Stand back about 20m from the Dome in alignment with the two sight pins and measure bearing to the sight
pins using a compass.
e This completes your Dome antenna assembly.

16 MHz Combine Antenna

The 16 MHz combine antenna is the same in physical design as the 13 MHz combine antenna.
See instructions in the last section for installation.

25 MHz Combine Antenna

Please contact CODAR customer support at support@codar.com for additional information.

42 MHz Combine Antenna

Please contact CODAR customer support at support@codar.com for additional information.
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Configuring the SeaSonde

This configuration section is for brand new systems that have been pre-configured at CODAR. To pre-configure you
own computer and load the SeaSonde software see the computer set-up manual that corresponds to your operating
system

Rack Mounting Chassis System.

The rack mounting chassis system consists of a SeaSonde Receiver (RX), a SeaSonde
Transmitter (TX), a Mac Mini computer with monitor, keyboard and mouse.

All connections to the RX and TX chassis’ are on the back panels. The following pictures show
the connectors on the back panels.
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SeaSonde Receiver Back Panel Connections
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SeaSonde Transmitter Back Panel Connections
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Connector Descriptions

1.

2.

10.

1.

12.

13.

14.

15.

DATA/COMM. OUT TO COMPUTER: USB-B style connector for data interface. Use a
USB A/B cable (supplied) to connect to one of the USB ports on the computer.
TRANSMIT CONTROL: DB-9 female connector. This is a port for communication and
pulsing control between RX and TX. Use a DB9 male to male cable (supplied) to
connect to TRANSMIT CONTROL (14) of the transmitter. The DB9 cable is a pin-to-pin
cable.

REMOTE: DB-9 male connector: This connector is for advanced users. For normal
operation, this connector is not used.

ANTENNA 3/MONOPOLE: BNC female connector. This is the input for channel 3
signal. For separate transmit/receive antenna configurations, connect this to antenna 3
of the receive antenna. For combine antenna systems, connect this to RECEIVER
ANTENNA 3 (OPTIONAL) (12) with the brown BNC cable supplied.

ANTENNA 2/LOOP 2: BNC female connector. This is the input to channel 2 signal.
Connect this to antenna 2 cable.

ANTENNA 1/LOOP 1: BNC female connector. This is the input to channel 1 signal.
Connect this to antenna 1 cable.

TRANSMIT DRIVE OUT: BNC female connector. This is the transmit r.f. signal
waveform to be amplified by SeaSonde Transmitter. Connect this to TRANSMIT DRIVE

IN (13) on the transmitter use the black BNC cable (supplied).

GPS ANTENNA (OPTIONAL): BNC female connector. This is to connect the GPS
antenna to the SHARE module. Connect this to the GPS antenna with the cable
supplied.

Power inlet connector. Connect this to one of the outlets of the surge protector
(supplied) with a power cable (supplied).

Switched Outlet to Computer: AC Outlet. This connector is not used in normal operation.
For special situations where the computer experiences frequency freeze ups, this outlet
can be used to reboot the computer with a watch-dog setup during freeze ups.
TRANSMIT OUT TO ANTENNA: N female connector. This is the r.f. power output of the
system. Connect this to the transmit antenna cable.

RECEIVER ANTENNA 3 (OPTIONAL): BNC female connector. This is the receive
signal from the combine antenna TR channel. See connector 4 above for connection.
TRANSMIT DRIVE IN: BNC female connector. This is the input to the r.f. power
amplifier. See connector 7 for connection.

TRANSMIT CONTROL: BNC female connector. See connector 2 for description and
connection.

Power inlet connector. Connect this to one of the outlets of the surge protector
(supplied) with a power cable (supplied)
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Mode of operation

SeaSonde electronics and associated computers are designed for continuous operation. In the

event of power interruption, the system would resume normal operation upon power recovery. It
is recommended that the system uses a UPS for uninterrupted operation of the SeaSonde data

collection. The UPS also provides power regulation and filtering.

Confirm electronics rack cable connections

Confirm that following cable connections are made.

TRANSMIT DRIVE OUT (receiver) <> TRANSMIT DRIVE IN (transmitter)
TRANSMIT CONTROL (receiver) <> TRANSMIT CONTROL (transmitter)
ANTENNA 1 LOOP 1 (receiver) < Loop 1 (receive antenna)
ANTENNA 2 LOOP 2 (receiver) < Loop 2 (receive antenna)
e TRANSMIT OUT TO ANTENNA (transmitter) <> transmit antenna
e GPS to GPS antenna

For separated transmit and receive antennas:

e ANTENNA 3 MONOPOLE (receiver) < Monopole (receive antenna)

For combined transmit and receive antenna:

e RECEIVER ANTENNA 3 (OPTIONAL) (transmitter) <> ANTENNA 3 MONOPOLE (receiver)

Initial Power Up

The SeaSonde is shipped with a surge protector where the equipment should be plugged in.
The power cord for the surge protector input is of the US plug if the system is for 110 V and
European plug for 220 V systems. This power cord should be plugged into the UPS power
supply. For temporary testing, this plug can also be plugged into the wall mains if the power
from the mains is not too dirty.

e  Confirm the transmitter is switched off and unplugged.

e Connect the computer to the receiver with the supplied USB cable

e Plug in the computer to the power cord extension and plug into the surge suppressor shipped with your
system.

e Turn on the surge suppressor power.

e Press the power button on the computer.

e After the computer starts up, quit all applications.

e  Plug in and switch on the receiver.

e Click the SeaSondeController icon in the Dock or in SeaSonde/Apps/RadialTools.

e Choose Receiver Controller > Select Port... menu item.

e Confirm SeaSonde Receiver is displayed in the pop-up menu. If not, choose SeaSonde Receiver from the
pop-up menu.

e Click OK.
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Configure Site Information

Computer Name

e Select a descriptive four-character code for your site (characters A-Z, a-z, 0-9)
e Change the computer name in System Preferences-> Sharing by adding your site code using the format
SeaSondeSite-XXXX (where XXXX is your four-character code)
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e Delete any existing RadialConfigs folders found in /Codar/SeaSonde/Configs

Site Parameters

e Launch the SeaSondeRadialSetup program. Located in the Dock on the Desktop or in
SeaSonde/Apps/RadialTools.
e  Select the type of system (Long/Standard/High Res) you are operating.

Install C&nﬁg._lra.ﬂnn Files
Radial Configuration Files are Missing,

Seafonde Long-Range System
[ Using SMHz Low Band
[_/Using 12MHz High Band

Seadpnde Sanderd Syitem

IUsing 12MHz Low Band

(s} Using 25MHz High Band
Seasonde Hi-Resolution System
Using 25MHz Low Band

[ Using 42MHz High Band

Site Parameters in SeaSondeRadialSetup:

e  Enter your four-character site name in the “Site Code” box

Optional: add a site description in "Description” box.
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e Select your preferred timezone. Your data files will be referenced to and labeled with the selected timezone.
CODAR suggests using UTC. The timezone should match the timezone selected in System Preferences ->
Date & Time.

e Enter the WGS-84 latitude and longitude of the receive antenna separated by a comma in the “Location”

box. Make sure the N/S and E/W are correct. CODAR uses the Garmin handheld GPS to obtain this location
point.

SeaSonde Radial Site Sstup
Dietailed  Advanced  Owerview

Shorw Map
Sine
Sine Code O0X Wil open Safar] maps.google.com to

show the current entered location
Description Long Bange 5

Timezone |UTC v | UTE i T iy
Location  DO®00.000°W, 000"00L000E Sheww Map
Trarit

Trassenirer Srtatug
Center Frequency 4 820084 | MHz Rieuvar B Availabile

Max. Bandwidth 150  kHz L I;:l;t;mm Fulte,
Range Resolution |4 545 = km OH Enable

Anterng

Sight Arrow " | Magnetic + | Declination is -5,7

Phase Correction  Loopl *  Loop2 .

Process Racials with Measured Fabiermn Install Pattern Sioe Eadd H Hel S50
Locadian & nidl del
Antenna Bedring b oo sl
Loop PRases e ool sl
s darEeragi will Lake efect afios Save.

Revert Save

Transmit parameters:

e Enter your licensed operating frequency in MHz. Use the center frequency of your authorized bandwidth.

e  Check mark the “Max Bandwidth” box and type in the maximum bandwidth you are allowed for your licensed
frequency.

Antenna parameters:

e Enter the magnetic compass bearing of the black arrow of the two nylon index markers.
Note: Phase corrections and the measured antenna pattern file will be installed later.
Configure Receiver Settings in SeaSondeController

e Choose Receiver Controller > Advanced Control.... The Advanced Receiver Controller dialog appears.
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Set Attenuation to 20 and press the “Atten” button next to the value field.
Choose Receiver Controller > Transmit Drive Control

B0 .. Tranama Drive il

Tranumh Oewe Corerod

Trasirt | Pulie £ Anen A0 |

Trip Tuern CFF Tranumi Drhee Wharn
i i v Seana Chaci
El! Whes Bow Temperators Eaceeds 800
] wheen £ bt Mty
= whes ML Unlezhoed
Wi GFS Unasmeoes
Ervniride Transma
Upen Extgraal Hak High (=] Low

Uncheck the check marked Transmit Drive Trips so that the Transmit Drive Control window looks like the pic
below. This is to make sure that the Transmit does not get tripped off during startup. You will be resetting the
Transmit Drive Trips later in the configuration.

800 Transmit Orive
Tranymit O g Congnal

Tranwmia | Fareed O 3 anen 2.0 | d8

Trip Tam Off Transmit Drive When
Untd First Status Check
‘Whan Rowr Temperature [xcesds | 20 | *
‘When GFS kot Ready,
| Whan PLL Unlocked,
‘Whizn CFS Unsynaoed.
Orverride Transmit
Upen Extarnal Halt [ kigh sl Lew

Press Store in the Receiver Advanced Controller window to save these settings before you start up the
transmitter.
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Call sign recommendations

Powering up the transmitter

Confirm that the transmitter power switch is off.

Plug in the transmitter power cord.

Click the SeaSondeController icon in the Dock.

Receiver Controller > Transmit Monitor.... The RC1 Transmit Monitor window appears.

B0.n Transmit Monitor
u Foreard ' Beflected
— —
N O\ -
L L L] ~1h# N
7 'Wans T VEWR
[ Feport Unavailable _ Termperature
[ svoc sty "
[l 2evec suppty
Chassis. Temperature &
E Amgkfier Temparsture “lhe T

In the Advanced Receiver Controller window, attenuation (Atten) should be set to 20 dB and settings should

be stored.

Switch on the transmitter. The question marks under the Forward portion and Reflected portion of the
window should turn from question marks as in the picture above, to values similar to the picture below.
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Confirm that the values in theTransmit Monitor are as follows:

Reflected (power) is less than 25% of Forward (power).
VSWRis 3 or less. VSWR is the ratio next to the reflected power measurement.
Identify and correct problems if VSWR is greater than 3.

Repeat the following steps until Forward (power) in the RC1 Transmit Monitor window is 40-50 watts and VSWR is
less than 3.

e Reduce Atten from

20 to 10 and press the Atten button. If VSWR is less than 3 continue.

48



SeaSonde SSRS-100 Operator’s Manual

e Reduce by 1 the entry in the Atten field of the Receiver Controller window. For example, enter “9” if
the current value is “10”.
Click the Atten button.
Forward power should be around 40 - 50 watts, VSWR should be 3 or less.

Configure GPS synchronization (SHARES systems only)

Confirm the GPS antenna has a clear view of the sky.

Confirm the GPS antenna cable connects the GPS antenna to the receiver.
Click the SeaSondeController icon in the Dock to make it active.

Choose Receiver Controller > GPS Monitor....

The RC1 GPS Monitor dialog appears:

A5 GPS Monitor
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Confirm that at least four satellites are shown by the Satellites indicators.
Observe the Survey progress bar . Wait until Survey is complete.
Store the SeaSonde’s position:
e Confirm the Position Stored indicator is green. If it is not, follow below steps.
e Select the checkbox next to the pop-up menu labelled Get Versions.
e Choose Store Survey GPS Position from the pop-up menu.
e Click the Go button. The SeaSonde’s position is stored.
e Repeat this step if the position is not stored.
Confirm all indicators are green.
Go to the open Transmit Drive Control window and recheck all of the Transmit Drive Trips as shown in the
Window below; Until First Status Check, When Rcvr Temperature Exceeds 40, When GPS Not Ready, and
When PLL Unlocked should all be checked.

- MaN Transmit Brive
Tramsia Dvise Cantral

Teansmit| Pulie : Arree 4.0 dB

Trig Turn Off Transenit Drive When

7 uncil First Saatus Chack
!':M-an Rewr Temnperature Exceeds | 40
o when CPS Mot Ready
o When PLL Unlocked
When CFS Unsynced
Orerride Transmit
Upan Extermal Halt High (&) Low

e  Store these settings in the Receiver Advanced Controller window:
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o Click Store to store settings as switch-on defaults. The settings are stored in receiver memory
location 1.
e Enter “SAVE 2" in the Send field.
e Click Send to store settings in receiver memory location 2. This is a backup.
Capture an image of the Advanced Receiver Control dialog:
e Press Command-Shift-4.
e Press the Space bar. The pointer changes to a camera.
e Click the Advanced Receiver Control dialog.

Note: An image of the dialog named “Screen Shot #” (where # is a time stamp) is saved to the Desktop. Rename it to
something like “ControllerSettings.”

Click the SeaSondeAcquisition icon in the Dock and look for Bragg peaks in the Spectra window. Note that
shape of Bragg peaks will change from site to site. A typical Spectra with Bragg peaks for a long range
system is shown below.

Confirm that Bragg peaks are present in A3 (Monopole - Channel 3) Spectra Map

Select “Monitors” menu->Cross Spectra Power Map->Antenna 3

B 00 Spectra Map

511
I 007 Sweeps To Mext C5

Confirm that Bragg peaks are present in A2 (Loop 2 - Channel 2) Spectra Map
Select “Monitors” menu->Cross Spectra Power Map->Antenna 2
Confirm that Bragg peaks are present in A2 (Loop 1 - Channel 1) Spectra Map
Select “Monitors” menu->Cross Spectra Power Map->Antenna 1

Computer reboot test

Choose Apple menu > System Preferences.... The System Preferences window appears.
Click the Users & Groups icon. The Users & Groups pane appears.
Click the SeaSonde user’s icon. (The user is normally “codar”.)
Click the Login ltems tab.
Confirm Sentinel is listed in “These items will open automatically when you login:”.
If Sentinel is not listed, add it to the list:
e Click the “+” button.
e Select /Codar/SeaSonde/Apps/RadialTools/Sentinel
e  Click the Add button.
Choose Apple menu > Restart.... The “Are you sure you want to restart your computer now?” dialog
appears.
Click Restart.
After the computer starts up, confirm that Sentinel launched the processing suite.
Confirm that data are being acquired in SeaSonde Acquisition’s Spectra Map window.
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e Re-visit the site in 6 or more hours and confirm that CSQ, CSS, RDLi radials are being created and stored in
their respective folders in /Codar/SeaSonde/Data/Spectra/... and
/Codar/SeaSonde/Data/Radials/|dealPattern/

*sThe Rack Mount Style SeaSonde remote unit is configured and operatinges

Low Power SeaSonde System

Scope

Low Power SeaSonde (LP SeaSonde) is a self contained instrument which, in conjunction with relevant SeaSonde
antennas and interconnect cables, measures the radial currents of the ocean surface. The LP SeaSonde can be
powered with 110 V/220 V AC power with the supplied AD to DC converter or directly powered by a 24 V DC supply.
The system is of a weather proof design with built-in cooling system.

 — iy s i — — 1

| —

-l S —
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The system is shipped in a hard case with the following items included:

ltem Qty Description

1 1 LP SeaSonde transceiver enclosure

2 1 AC-DC 24V power supply

3 2 24V power cable

4 1 Power surge suppressor

5 1 AC power cord (110 V US plug or 220 V European plug depending on your order)
6 1 Power cord from surge suppressor to AC-DC 24V power supply
7 1 Power cord adapter for laptop

8 1 Mac Mini

9 1 GPS antenna for SHARE

10 1 Mast for GPS antenna

11 1 SHARE cable

12 1 Drain hose

WARNING: DO NOT power on the system without
following the instructions. Damages might occur!!!

Mounting

Installing Mac Mini

PODN~

Open the front door by sliding 4 latch locks out and pull the door open.
Open the front plate by pulling on the knob.

Remove all the packing materials (foam blocks).

Install Mac Mini as show in picture below
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Power connection:

1. Power cord connects from wall outlet to surge suppressor.
2. Adapter cord connects from surge suppressor to DC power supply.

53



SeaSonde SSRS-100 Operator’s Manual

3. Make sure DC power supply switch is turned off when making connections. DC cables (orange cables with
circular connectors on both sides) are indentical on both ends and from each other. They connect from DC
power supply to 24 DC and 24 V AIR CON connectors at the bottom of the SeaSonde enclosure.

Cable connections

1. Connect one end of SHARE cable to GPS antenna via mast and the other end to the enclosure. Both ends
of the SHARE cable are fitted with TNC connectors. It is important that the GPS antenna has a clear view of
the sky to ensure good GPS signal reception.

2. Connect transmit antenna cable to the N connector at the enclosure bottom labeled ‘TX'.

3. Connect receive antenna cables to Ch1, Ch2 and RX3 at the bottom of the enclosure. For combine antenna
system, RX3 will not need to be connected. Ch2 uses reverse polarity TNC so Ch1 and Ch2 connections
are not interchangeable.

4. Connect lightning protection ground to a proper ground. Use local guidelines for grounding practices or
consult a licensed electrician.

5. Connect internet to the ethernet connector at the bottom of the enclosure.

6. Archive drive (not supplied) can be connected to the USB connector at the bottom of the enclosure.

Power On/Power Off Procedure

To turn on the system, press the power switch to on. See picture below for the 24 V power supply and the
corresponding switch.

To turn off the system, press the power switch on the 24 V power supply.
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For users who desire to observe the actions during the turn-on sequence, here are the steps to follow:

1. Slide the 4 stainless steel spring locks outwards to unlock the front door. One might need to loosen the bolts
on the spring locks if the bolts have been previously tightened. It is recommended to press the front door
while sliding the locks to minimize the paint scratch.

2. Open the front door.

3. Pull on the knob near the top of the face plate. You should see the interior of the unit as shows in the
following picture. In the picture is also shown the names of various components inside the unit.

Internal Module Layout

Front Panel Board Module

GPS Module

AWG Module

TR Module

Rx Module

Filter Module

Power Reflector Module

RF Power Amplifier

9. Low-pass Filter

10. DC Power Supply Board

11. DC/AC Converter

12. TEC Cooler

13. SeaSonde Software License Key
14. Computer

15. Lighting Protection Surge Arrestors

NSO AON =2

4. When the power switch is first turned on, one would expect the following events to follow:
a. On the back plane board, one should see reflections of 4 LED’s as shown in the picture below. A
few minutes after power on, one should hear a click sound followed by the turning on of a fifth LED
which indicates the turning on of the power ampilifier.
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b. On the left side of the Front Panel Board Module, one should see green LED on steadily, flashing
yellow LED and no red LED. If one sees a steady red LED, it indicates communication issue
between the computer and AWG module. If red LED flashes, it indicates a low voltage condition.

c. On top of the DC/AC converter, one should see a green LED light up.

d. In front of the Mac Mini computer, one should see a white LED light up. The white LED is a little
dim and one might not see it clearly with strong background light.

e. The interior fan on the TEC cooler should be running at all times. The fan outside the enclosure
turns on only when the TEC cooler is activated.

5. ltis essential that one closes the front door of the Low Power SeaSonde unit during normal operation.
Coastal climate can cause corrosion of the components inside the unit if the door is left open for extended
period of time.

Connecting to the SeaSonde computer from a laptop

The SeaSonde computer does not come with its monitor/keyboard/mouse set. It is strongly recommended that one
communicates with the SeaSonde computer via internet preferably with static IP or with domain name server. This

should be done during the installation with coordinated efforts from the local internet providers.

In the event that an internet connection is not available, one can connect to the SeaSonde computer through one of
the following methods. Such connection will be going through the wireless ports (airport) of the computers. It is

highly recommended that the front door of the Low Power SeaSonde unit is left open and the front plate pull open to
expose the computer.

1. Via Timbuktu software.
If your laptop is installed with Timbuktu software, you can connect to the SeaSonde computer by the following steps:

e  Open TimbukTu by click on Open Timbuktu Pro
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e Choose TCP/IP Scanner tab and click Scan button
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e Double click on the SeaSonde computer found on the list. You will then be prompted for the login
information.
e After log in, you will be able to control the SeaSonde computer from your laptop.

2. ViaVNC

If your laptop has Mac OS 10.6 or later, VNC is already installed as part of the operating system. To connect via
VNC:

e Click Go on the top menu bar of the finder window (For novice Mac users: click on the desktop once to get
to finder window).
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e Click Connect to Server... to pop up the following window
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type in the vnc server address for the SeaSonde computer or click on the address in the list.
Click Connect button

You will then be prompted for the login information.

After successful login, you will be able to control the SeaSonde computer from your laptop.

If you have trouble finding or log into your SeaSonde computer with either of the above methods, you might want to
turn off the 24V power supply and start over from power on. It has been observed that for some of the Mac OS 10.7
operating systems, timbuktu or VNC might not work after a Sentinel reboot.

Initial Status Check

A few minutes after power on, the Sentinel program (For details of Sentinel, please attend Codar Training) which
automates the SeaSonde control and data acquisition process would reach a steady state. One can now check
some of the key status information. The following are the suggested steps.
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1. Bring SeaSonde Controller to the foreground by clicking on the following icon on the dock.

2. Activate the power monitor window by clicking Receiver Controller -> Transmit Monitor ...

#  SeaSondeController File Edit LTTIINTITITNITY Transponder Contraller Window  Help

Standard Centrol... 1l
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20121109 D4Z608 Sentinel 0007 Manitar. . apm pid{2F806) niee(l
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3. The power monitor window now opens as shown below.
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4. Check the forward power and reflected power. The forward power should be about 40 W and it is desirable
to have the forward power light on green. The VSWR is the value underneath the Reflected meter. lIts value
should be less than 3:1. For VSWR values larger than 5:1 or at inf:1, the user should turn off the Low Power
SeaSonde unit immediately and contact Codar Support (support@codar.com) for further actions.

5. Activate GPS monitor window by clicking Receiver Controller -> GPS Monitor ...

6. You will see the GPS monitor window as shown below.
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One should see at least 4 green bars on GPS satellites. Otherwise consult the SeaSonde Operator’s
Manual or contact Codar Support.

Check the RC1 RF Monitor window for proper operating parameters. The center frequency, bandwidth and
sweep rate should match what is expected for the site. PLL should always show ‘Locked’ in green. PPS
should show ‘Valid’ after some time.

8.0n RC1 RF Monitor

Center Freg. : Bandwidth : SwpRaote @ Xmit PLL : PP5 Align
13.474%91 MHz: -51.5 kHz: 2.88 Hzr: SEW : Locked : 1458.8ps

Range Cutoff : Range Step : Receiver: Ample : PPS : Version
73 B7km 2.912km : 25°C = 33°C : Volid : AWGI 3.12

Check #553 : Receiver Settings makch stored.

By now if everything checked above is normal, one should see sea echo signals on the Spectra Map window
of SeaSonde Acquisition.

The following figure shows a typical sea echo signal from the SeaSonde system. By default, the signal from
dipole antenna (channel 3) is shown. One can control click (press and hold control key while clicking) the
graph to look at signals from one of the two loops (channel 1 or channel 2). The vertical axis label will
change to A1 or A2, respectively after your selection.

B ) 471 Sweeps To Rext (5

If you see sea echo signals from all 3 channels, it implies nominal normal operation of the SeaSonde system. Further
details on signal integrity falls outside the scope of this guide and should be pursued by advanced users only.

Radial Velocity Vector Examination
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Depending on the operating frequency and the radial site settings (See SeaSonde Operators Manual for details), the
first set of radial velocity vectors (commonly called radials) will be generated 1 to 3 hours after system turn on. For a
5 MHz system, the first set of radials will normally be generated 3 hours after system turn on.

To examine the radials:

Click on the finder icon on the lower left corner of the dock to launch finder window.

Select Configs, SiteDefinitions and drag the corresponding site map into SeaDisplay as shown in the
following picture. The site map is normally generated during SeaSonde installation. For details of site map
generation, consult SeaSonde Operators Manual.

Codarats e wlaunRadan orfgy =1
Jly ppleabom || S FasiaTraigy —
L Radawebe b s |
= Dwbrep L R DL w
L i ST B et TG 3 h
Vil aripn Y Drag Site Map 1o SeaDisplay
= Mg e \ - !
L Brvbien N
Ca i

e Now select Radials, IdealPattern or MeasPattern and drag one or more of the .ruv files into the site map.
The MeasPattern files are only available after the antenna patterns are measured, processed and installed.

For details of the antenna pattern measurement and installation, see SeaSonde Operator’s Manual for
details.
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One should now see the radials plotted on the site map as shown below. By placing the pointer at one of
the utility icons, the pop up would display the function of that icon. one can browse the radials plots frame by
frame, making a radials distribution plot, save the image to a file or save the frame by frame plot into a
movie file.

To print the plot, one can save the image to a file and send it to a printer. Alternatively, one can save any
part of the screen display into an image file (screen dump) by:

° 4 cmd-shft-4
° 4+ drag a window in the portion of the screen which one intends to dump
. +the image will be saved on the desktop with a file name like “Screen shot date time”

62



SeaSonde SSRS-100 Operator’s Manual

Radial Web Server

Radial web server is a convenient tool for users to monitor SeaSonde remote sites with any device which has a web
browser such as laptops, tablet computers, mobile phones, etc.

To access the radial web server, open your browser and connect to the site computer using the link:
http://static_ip:8240
where static_ip is the IP address of the SeaSonde computer. :8240 is the port used by the web server

Contact the site installer or the person maintaining the site for the user-id and password for that site.
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If you click Logs on the left column, the browser will bring you to a page like the following.

If you change something to the SeaSonde system or observe a significant event at the site, you should write them in
the box marked by “Enter new site event” and click “Submit” after done.

If you scroll down to the bottom of the page, you will see all the log entries entered.

For other details of the radial web server, you can play with various links or consult SeaSonde Operator’s Manual.
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SeaSonde Controller deviations from conventional SeaSonde

1. Do not change attenuation settings as they no longer function the same way a conventional SeaSonde
functions.

2. Do not change pulse shape to on. Leave it at off position. SeaSonde may not function properly with the
pulse shape on. (With the pulse shape off, pulse shaping is done automatically by the RF ampilifier).

3. For normal operation, keep the freq band in ‘high’. Switch to ‘low’ only for diagnostics purposes only. (Low
Power SeaSonde is fitted with a single band filter. The freq band switch is now used to turn on/off the DC
bias of the loop stick antenna pre-amp).
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Measuring the Antenna Pattern

Measurement with a transponder

This section describes how to perform a SeaSonde antenna pattern measurement (APM). The SeaSonde uses an
APM to calibrate the antenna response vs bearing for local, site-specific conditions resulting in increased accuracy
and reliability of the data outputs.

It is necessary to do a dry run / walking APM before hiring a boat. Follow the steps below within a day to a
week before doing the actual boat pattern. This ensures that all of your equipment is working and you can

the below steps for an APM and trying to collect the land points that are described at the end of this section.

ltems Required

Transponder (SSTR-101) including:
e  Transponder charger
e Custom USB data cable
e Whips
e SeaSonde Remote Unit (SSRS-100) including:
e Antenna(s), cables, Rx chassis, Tx chassis and computer
e  GPS navigator capable of storing time-stamped track. Garmin GPS 60, GPSMAP® 60 or GPSMAP® 76
product lines are recommended.
e Transponder Extender Kit (SSTR-EX) if operating frequency < 20 MHz, including:
e four piece green whip antenna
e whip antenna feed/base
e grounding cable
e custom transmit cable
Voice communications (2 x two-way radios, cell phones, etc.)
Boat

Whip Configurations Required

SeaSonde Model Antenna Configuration **Antenna Configuration
(Boat Run-APM) (Walking-WAPM)
5MHz Antenna feed w/green whips + OCEAN three 8’ white whips on sides and
GND top
9MHz Antenna feed w/green whips + OCEAN three 8’ white whips on sides and
GND top
12MHz Antenna feed w/green whips + OCEAN three 8 white whips on sides and
GND top
16MHz Antenna feed w/green whips + OCEAN three 8’ white whips on sides and
GND top
25MHz White whips (2 - 4’ whips on sides + 8 on |two 4’ white whips on sides and 8’
top) top
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42MHz White whips (2 - 30” whips on sides + 64" | White whips (2 - 30” on sides + 64”
on top) top)

Charging the transponder battery (done at least
one day before the APM)

e Open the transponder case. Inside, there is a printed circuit board
with a socket labeled CHARGER and a power switch.
Plug the transponder charger into an electrical outlet.
Plug the transponder charger’s round plug into the CHARGER
socket on the printed circuit board. The FAST CHARGE indicator
on the charger will light red while the battery charges.

e When the FAST CHARGE indicator light turns off, the battery is
charged. Keep the battery fully charged to lengthen battery life.

e  Unplug the round plug from the CHARGER socket.

Configuring the transponder

e Plug the USB data cable into the USB data port on the side of the
transponder case.

e Plug the standard USB connector of the data cable into any
available port on the SeaSonde computer, or laptop with R7U1 or later.

Monopaole Transponder Antenna Port

USH data port

Grounding pntenna por

Switch on the transponder.

On the computer, open SeaSondeTransponder app located in SeaSonde/Apps/RadialTools. The
Transponder Controller window will appear. If the transponder is being recognized there will be green
lettering saying, “Transponder Connected.”
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[ K4 Transpander Coonroller
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e |f the transponder is plugged into the site computer, you simply press the Initialize button in the Transponder
Controller window. This will set the transponder center frequency to match the site and set the appropriate
Offset for that frequency. Press Store when done.

e If the transponder is plugged into a computer other than the site computer. You can press Initialize in the
Transponder Controller window, enter the desired center frequency (which is your SeaSonde operating
frequency) and press the Frequency button. The offset will be entered in automatically. Press Store when
done.

e The center frequencies and corresponding offsets for transponder configuration are listed below.

SeaSonde Model Frequency (center) Offset
5MHz Your center frequency 20.7 Hz
9MHz Your center frequency 20.7 Hz
13MHz Your center frequency 40.7 Hz
16MHz Your center frequency 40.7 Hz
25MHz Your center frequency 40.7 Hz
42MHz Your center frequency 80.7 Hz

Switch off the transponder.

Quit SeaSondeTransponder app.

Switch on the transponder.

Launch SeaSondeTransponder app.

Confirm the transponder settings are the same as what you stored.
Switch off the transponder.

Unplug the USB data cable connector from the transponder.

The transponder is set up for an APM.
e Place the transponder at least 1 wavelength away from the SeaSonde receive antenna.

e Use the whip configurations in the table at the beginning of this section for walking APM.
e  Turn the transponder on.
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Configure the Receiver and Locate the Transponder Peak

Quit all applications except SeaSondeController and SeaSondeAcquisition.

Click the SeaSondeController icon in the Dock.

Choose Receiver Controller > Advanced Control.... The Advanced Receiver Controller dialog appears, take
a screenshot of your original operating settings if one does not already exist on the desktop (shift +
command +4).

B.O0] . Recetver Cootroller
Fiesy 4. 400000 Wiz Savep Rate | L0 He
L] 200,357 kiz Banidwosrk | J00 kitr
Blank AHE 400 m Hankmg  Pulwn
EDelay 8,550 Trweimit | Pulse
Altan 4.0 = Freq. Sweep | Sweep
aign 100,0/ Freq. bae Rane | ThO0sb
- VER vmpep Disegiion - Dowm
By "= Sampling | 241 Tud
g Step:0LF4Eem Max d4km
Samples per Sweep iz £274 Freg. Baad | High
Refresh Sbore Pislse Shaping | OR

e Choose Receiver Controller > Receiver APM Configuration. When prompted by the dialogue box press OK.
The proper settings should be entered into the Advanced Controller window automatically. The values can
be checked to the look up table below.

Clicking OF will change some recaiver iettings o
that it will receive the tramsponder signal better,
Be sure 1o restore the recensar TeRtangs when

Rt bl

Cancel | H_ )

SeaSonde Bandwidth Blanking Bdly Attenuation Sweep Pulse
Model s Boat/Walking | Frequency Shaping
5MHz 25kHz 60* ~4.75 15/30db** 2Hz Off
9MHz 25kHz 60 ~4.75 15/30db** 2Hz Off

13MHz 50kHz 60 ~4.75 15/30db** 4Hz Off
16MHz 50kHz 60 ~4.75 15/30db** 4Hz Off
25MHz 150kHz 60 ~4.75 15/30db** 8Hz Off
42MHz 150kHz 60 ~4.75 15/30db** 8Hz Off

At the SeaSonde computer, click the SeaSondeAcquisition icon in the Dock.

Choose Processing > Enable Loop Diagnostics. Two windows appear, The Loop Diagnostics window and
the SpectraRangeDisplay window.

In SeaSondeAcquisition go to Monitors > Range Display menu item.

Confirm that the transponder signal peak appears in the Range Display window.
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Note. RangeDisplay is usually the easiest way to locate the transponder peak, and determine approximately
what Range cell it is in. You see what range cell the peak is in on the X-axis of the RangeDisplay. The
Transponder peak in the picture above is in approximately range cell 11. However, occasionally the peak
can not be seen in this window.

After the initial set of sweeps, confirm that the transponder signal peak appears in the SpectraRangeDisplay.
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e  The APM settings should put the transponder peak around range cell 11. To define the peak to the range cell
where it is strongest, use the Loop Diagnostics window. Change the range cells in the Search For Peaks
section. Start out with the range cells wide open, in the pic below the software will be looking for the
transponder peak between range cells 5 to 15. At the top of the SpectraRangeDisplay the Range Cell with
the strongest peak is reported, in the example above is it range cell 11. Fine tune the Loop Diagnostics

Range Cells so that the transponder peak is isolated between 1 or 2 range cells.

e  Set Doppler cells search limit from 6 to -6 to search for transponder peak between these doppler cells.

(Note: It should be 6 to -6 as shown in the picture and not -6 to 6). Reason for

this is we want to avoid

searching near the DC region(Doppler cell 0) where you can pick up bragg peaks instead of transponder peak. You

can always

is actually located during your APM.
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Once the peak is located. Turn the transponder off and watch the peak go away in the SpectraRangeDisplay
window.

Turn the transponder back on and make sure that the peak you have determined as the transponder peak
returns in the SpectraRangeDisplay.

Shut off the transponder and get in position for the boat or walking APM.

Set up the transponder antenna on the boat
Transponder on a boat (SeaSondes operating below 20 MHz)

Assemble and mount to the boat the four-piece whip antenna and feed included with Transponder Extender
Kit (SSTR-EX).
Attach the transmit signal cable type N connector to the antenna feed, the white wire to the Monopole
Transponder Antenna Port and the black wire to one of the grounding antenna ports.
Ground the antenna feed or one of the transponder grounding antenna ports to the seawater connecting the
20’ grounding wire to seawater

e directly over the side of the boat with end of wire weighted to stay in water or

e via a seawater ground point on the boat or propellor motor.

Transponder on a boat (SeaSondes operating above 20 MHz)

Attach an eight-foot fiberglass whip antenna element in the Monopole Transponder Antenna Port on top of
the yellow transponder case.

Attach an eight-foot fiberglass whip antenna to BOTH of the grounding antenna ports on the front and back
of the transponder case.
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Transponder carried on land

Attach an eight-foot fiberglass whip antenna element in
the Monopole Transponder Antenna Port on top of the
yellow transponder case. Attach eight-foot fiberglass
whip antennas to BOTH of the grounding antenna ports
on the front and back of the transponder case. See table
for the whip configuration that is suggested for your
operating frequency.

Set up tracking on your GPS
handheld

Set up your GPS navigator to log a track.
Record track entries by time increment: 1 to 5
seconds for a boat APM, depending on
memory available in your GPS. Always use 1
second intervals for walking antenna pattern. At
least one GPS measurement (called an epoch)
needs to be made in each angular bin of the
coverage arc.
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Synchronize the SeaSonde computer clock with the GPS navigator clock by going to SeaSonde Controller
then Receiver Controller > GPS Monitor and comparing it to the time on the GPS device being used for the
APM

Note: Track files downloaded from the GPS unit must contain a date and time stamp for every position recorded.
Garmin models only save this information in the ACTIVE track log

Set up the SeaSonde to Log Data

Click the SeaSondeAcquisition icon in the Dock to select SeaSondeAcquisition.

Choose File > Log Cross Spectra to deselect Cross Spectra logging.

Confirm there is no check mark next to the File > Log Cross Spectra menu item, indicating the item is
deselected.

Choose File > Log Time Series. Confirm that Time Series are being created in the
SeaSonde/Data/TimeSeries folder.

Measure Antenna Pattern

For a pattern from a boat transport the transponder to a test point directly in front of the antenna (~300m -
500m from shore) before moving to the starting point of the first arc. Turn the transponder on and make
sure the peak shows up in the SpectraRangeDisplay. Turn it off when confirmed.

Move the transponder to the starting point. For walking pattern it should be at least a wavelength away. If
performing a boat pattern try to be at least 500 m to 1.5 km away close enough to shore to maintain a strong
signal while traversing the two arcs.

Switch on the transponder.

Confirm that the transponder peak appears in the SeaSondeAcquisition’s SpectraRangeDisplay window as
described above. The transponder signal peak may be hidden from view if it is around a land feature on a
boat.

Confirm that Time Series are being created.

Start track logging on the GPS navigator.

Move the transponder (on a boat or by walking) in a circular arc centered on the receive antenna. Maintain a
constant speed no more than 4 knots. Walk slower than you think you should. The transponder signal peak
should remain in the same location in the SpectraRangeDisplay window. If the ship is traveling too fast the
peak will shift to the edge of the display and will serve as a warning to slow down.

For boat, at the end of arc 1, reverse course and retrace the arc in the opposite direction. Try to get the the
boat as close to shore as safely possible at the end of each arc.

For walking, if possible make two complete circles around the receive antenna. Keep the antenna at least a
wavelength away. Make one circle, at the end of the first circle, walk a circle in the other direction. This is
best case scenario, if a complete circle is not possible get as close to a complete circle with your arcs.

After completing two full arcs in opposite directions, uncheck File > Log Time Series in SeaSondeAcquisition
to end logging.

The person with the GPS should turn it off.

APM is complete.

Store APM data

Copy or move the following data to a separate folder. The data will be used to generate an antenna pattern file for
use with your SeaSonde remote unit.

The directory /Codar/SeaSonde/Data/TimeSeries, including the files in that folder.
The directory /Codar/SeaSonde/Configs/RadialConfigs, including the files in that folder.
The GPS navigator track log file.
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Land Points

Note: Land points may not always be possible due to geographic limitations. Perform land points only if it is
safe to do so.

e Using the GPS points at the end of both sides of the arc taken during the main APM, plot a straight line from
the SeaSonde antenna and a point on the land that would connect the point where the ship would have
touched the coast and the antenna.

Transponder Run from a Boat

E:E-éi't-ﬂaint

Water

e Create an APM land point by placing the transponder at the point described above following the APM
procedure for each land point individually. At the end of the process you will have the main APM data set of
TimeSeries (Lvl files) and GPS track files and two short segments of time with land point TimeSeries fils and
their GPS track files. Measure the SeaSonde antenna position with the GPS immediately after collecting
land points. This position information will be used as a reference when merging the land points and APM
arcs together.

e Send this information to CODAR Ocean Sensors for consolidation into a single file set. Usual charges will

apply.

Store APM data

Copy or move the following data to a separate folder. The data will be used to generate an antenna pattern file for
use with your SeaSonde remote unit.

e The directory /Codar/SeaSonde/Data/TimeSeries, including the files in that folder.
e The directory /Codar/SeaSonde/Configs/RadialConfigs, including the files in that folder.
e The GPS navigator track log file.

Re-Configure SeaSonde for normal operation

e Click the SeaSondeController icon in the Dock.
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e Choose Receiver Controller > Restore Hardware State. Press Load, Receiver settings should be back to
normal operation.

Making an Antenna Pattern File

e The GPS and SeaSonde data collected during the APM needs to be processed into an antenna pattern file
before it can be used to make measured pattern (calibrated) radial vectors. This can be done by CODAR
(fees may apply) or by someone trained in antenna pattern data processing. Refer to SeaSonde Radial
Suite Application Guide for CrossLoopPatterner and CODAR training materials for more information.

Measurement with AlS

Overview

The SeaSonde Realtime Automatic Pattern Generation Suite is a suite of software which utilizes the radar
echoes in CSQ files generated by ships of opportunity near a SeaSonde site, along with ship track information
provided by the Automatic Identification System (AIS) to automatically generate estimates of antenna patterns in
realtime. It was developed and has been tested with the Comair AIS-3R Receiver.

The software consists of four main components: the AIS Logger (sec. 3.1), the AIS Web Server (sec. 3.2),
the AIS Track Generator (sec. 3.3), and the AlIS Looper (sec. 3.4). All of these components run in the background
after being installed, and work in sequence along with SeaSonde Radial Suite software to generate AIS Loop files.
These loop files can then be used to create SeaSonde antenna patterns to increase accuracy of Radial Suite output
data.

Installation

Installation of the AIS Antenna Pattern Generation Suite requires the SeaSonde AlSPattern software
installer file, a Comair AlS-3R Receiver, an AlS antenna, and a SeaSonde USB Hardware key containing an AIS
Suite license. The AIS Suite is an add-on to the SeaSonde Radial Suite software, and requires SeaSonde Radial
Suite 7 installed on the computer.

Hardware Installation
Connect the Comair AIS-3R Receiver to the Mac computer with the supplied USB cable.

Connect the AIS antenna to the input on the AIS receiver labelled “Antenna.”
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No other connectors or cables are required. Continue to software installation.
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Software Installation

Plug the SeaSonde USB Hardware key in to the computer if it is not already plugged in. If an older Hardware key
does not contain an AlS Suite license, it can be upgraded to include the AlS license by CODAR staff
(support@codar.com).

Doubile click the installer file labelled “SeaSonde10R1-AlSPattern-Suite” and then double click on the
InstallAISPatternSuite app. Follow the onscreen instructions to install all AlS software components. Restart the
computer to finish the installation.

Operation

Operation of the AIS software to generate loop files is entirely automated. The necessary components
launch in the background when the computer starts up. The Logger, Tracker, and Looper processes use data from
the AIS receiver and the SeaSonde receiver to generate Track and Loop files in the /Codar/SeaSonde/Data/AlSData/
directory.

AlS Logger

The AIS Logger process takes the raw AIS data from the antenna and decodes the messages into usable
ship data. It stores the relevant ship information in a database to be used by other AIS Suite processes.

AIS WebServer

The AIS WebServer is a tool that provides access to the basic AIS data such as ship positions, headings,
and other details. It is not necessary to use this for normal operation and generation of loop files, but can be useful in
determining how much data the AIS receiver is collecting. The web server can be accessed through a web browser at
the address localhost:8241 to view ship position data. The address localhost:8241/ships also provides more detailed
ship information.

AIS Tracker

The AIS Tracker runs in the background. It takes the AIS ship data interpreted by the logger and generates
GPS Track files. These files are created in the /Codar/SeaSonde/Data/AlSData/AlS TracksToProcess/ directory. New
Track files are generated approximately every ten minutes. Track files have the .trk file extension.
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AlS Looper

The AIS Looper also runs in the background. It processes the GPS Track files and generates daily Loop
pattern files. Processed Track files are moved to the AISData/AlS TracksProccesed/ directory, and new loop files are
created in the AISData/AlSLoops/ directory. Loop files have the .loop file extension.

Cross Loop Patterner

In order to create usable antenna patterns for use with radial suite software, AlS loop files should be filtered
using the Cross Loop Patterner app. Cross Loop Patterner is included in SeaSonde Radial Suite software and can be
found in /Codar/SeaSonde/Apps/Tools/CrossLoopPatterner.app.

Open Cross Loop Patterner and drop a selection of AIS Loop files on the application window. If they are
properly formatted AIS Loop files, the top navigation tabs in the Cross Loop Patterner app will contain an option “AlS
Filter.” Select this tab.

AlS Filter Tab
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After filtering the data down to a usable set of points, the “Pattern” and “Finish” tabs can be used to smooth
and and save the pattern for use in measured pattern data. See next section for more details.

AIS Pattern Generation

AIS LOORP files are obtained by the use of the SeaSonde AutoAPM pattern kit. This kit consists of an AIS antenna and
receiver that are plugged into a SeaSonde Remote Site computer and used in conjunction with the AIS Pattern software
suite to generate LOOP files in a similar manner as using a transponder signal. The difference between a transponder
signal generated LOOP file and LOOP files generated from the AIS Pattern Suite is that instead of using a transponder to
generate a signal the SeaSonde instead uses the reflected signals from passing ships to determine phase and amplitude
values for the cross loops as well as the power pattern received but the mono pole/ di pole antenna. Today ships around the
world use the AIS ship positioning system to determine vessel speeds and direction in three dimensions which is in turn
used by the AIS Pattern Suite to determine the radial velocity and bearing of each ship signal detected by the SeaSonde
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receive antenna. At any given time there are a multitude of ships crossing the section of ocean that a SeaSonde is
collecting data from. These ships normally show up as small blips in the cross spectra.
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Figure 1

By using the AIS signal to marry the precise location of these vessels with the reflected signal echoes detected by the
SeaSonde, the AIS Pattern Suite can create LOOP files in a similar manner as using a transponder and handheld GPS.
The difference is that there will be more that one signal source for each LOOP file created. Normally the AIS Pattern Suite is
set to generate a composite LOOP file each day from the number of ship echoes the SeaSonde receives. Using Cross Loop
Patterner the LOOP files can be visualized (see CrossLoopPatterner Application Guide for more information of using
CrossLoopPatterner).
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As is evident there are a lot of signal sources in this LOOP file, each with varying peak signal strengths and quality. In order
to better determine the actual pattern one must use the filters in CrossLoopPatterner in order to get past the noisier or more
spurious data. Also it is possible and it is preferred to load multiple LOOP files in order to accentuate the stronger, better
quality signal that come from larger slower ships than from smaller or faster moving vessels. For the purposes of this
document three LOOP files will be used from a single SeaSonde spanning three consecutive days of coverage.
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Figure 3

Note the difference between Figures 2 and 3, Figure 2 shows the data in a single LOOP file while Figure 3 shows
CrossLoopPatterner loaded with three consecutive LOOP files spanning 3 days.

If the Pattern tab is clicked the following pattern is calculated:
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Figure 4

For comparison here is the transponder measured pattern of the same location using the traditional transponder APM
approach:
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Figure 5

Even in this unrefined state the main features of the antenna pattern are already evident but in order to get to the actual

pattern the low quality signal elements must be filtered out. CrossLoopPatterner is equipped with several data filters to help
with this task. The following section will detail each of these filters.

CrossLoopPatterner Filters

The following is a brief description on these filters and how they can be used to help clean up an antenna pattern data set.

In the Cross Loop Patterner application there are two tabs that contain filters to help clean up the signal found in the LOOP
file. The first tab is called “Filter”, this tab contains the standard filters that are used in conjunction with a normal APM done
with a transponder carried by a person or on a boat.
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Figure 6

Radial Velocity - Keeps all points which have less than the entered velocity value. This filter is mostly used for filtering
transponder radial velocities (usually zero if the transponder is kept on a perfect arc) and us not very useful when using AIS
LOOP data.

Doppler Velocity - This filter keeps all points which are less then plus/minus the value entered in the filter window from the
average doppler velocity cell. Normally this doppler velocity cell is referring to the the doppler cell of the transponder peak
but in a AIS LOORP file there are multiple signal peaks to be considered, in this case the Doppler Velocity filter can be used to
remove the lower quality signals that may contribute erroneous information to the pattern file.

Signal Level - This filter will retain all the data points that have a signal to noise ratio greater than the threshold value
inputted by the user into the filter value in dB. These values will be visualized in the S/N graph from the Meas. graph tab.
This filter will remove any di-pole (monopole for older SeaSondes) channel signals that score less than the filter value. It will
only remove points from the cross loop channels (red for loop 1, blue for loop 2) where both loop 1 and loop 2 signal to noise
values fall before the set threshold value. This filter will have a large impact on the pattern and should be used carefully to
remove the worst data points only. There are finer filters that will be described later on to do further fine tuning.

Cut Left/Right Side - These filters are designed to remove the entered number of points from beginning or end of the LOOP
file. Usually used with a transponder LOOP to remove a bad part of a particular arc, these filters are not very useful in AIS
pattern generation and should be avoided for this particular application.

Filter Out Flagged Vectors - If this check box is activated this filter will remove any points whose Flag column is not zero.
Normally SeaSonde Acquisition sets this value to zero but a user can hand edit the loop file to remove certain points that are

deemed undesirable and are not removed by other filters.

When CrossLoopPatterner detects an AIS LOOP file or LOOP file set an extra filter set is activated and will be accessible
from the “AlS Filter” tab
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Figure 7

In the AIS Filter tab:

Local SNR Filter - Removes points that fall under the Signal to Noise value entered in the filter in terms of dB. The base
level is determined by the average noise floor calculated from the range cell of the peak signal calculated in LOOP file
plus/minus one range cell around this peak plus 6% doppler.

IIR SNR - Removes points that fall below the dB threshold entered from the calculated base value. This value is the noise
floor calculated after removing the peak signal and making a running average of the background noise of the LOOP file
throughout all ranges.

Bearing - This is a filter that removes the points that have fall below the histogram of bearing counts from the value given.
The histogram can be seen visually in the “Spread” graphic. This filter may help in removing spurious bearings that have
small amounts of data.

Range Width - Removes all points that are not within plus or minus of the range cells that are entered into the filter. The
centroid of this filter would be the range cell that contains the peak signal calculated in the LOOP file.

Doppler Width - Removes all points that are not within plus or minus of the doppler cells that are entered into the filter. Note
this also removes faster moving ships and tends to keep larger, slower vessels for APM calculation.

Bragg Vel - Removes all the points that are not within plus/minus the entered value in cm/s of the surrounding center of the
Bragg Peaks generated by normal SeaSonde operation. This filter can remove any ship echoes that may be influenced by
noise associated with the normal sea echo used to generate radial data.

Limit Sector - This filter limits the data points to be considered in terms of degree arc. Sometimes ships may be transmitting
AIS behind a SeaSonde on in a marina berth that would extend the pattern into a land path region that would normally not
be used for radials.

Limit Range - Excludes any points outside of the set radial range in terms of kilometers. This filter can be useful to omit
ships that are too far or too close and returning low quality data points.Creating patterns from AIS Generated LOOP files
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AIS generated pattern measurements are created from the measured reflected signal of a passing ship whose position is
known from the AIS (Automatic Identification System) transponder on the vessel. The method is similar to a normal boat
APM but in this case a transponder is not used rather the reflected signal echo off the vessel’'s hull. The size of the vessel
very much determines the strength of the return signal echo. By using the AlS signal the Auto APM software generates a
TRAK file that is married to the returned signal echo information which in turn is used to create a LOOP file. This process
generates a LOORP file every day for each ship track that is identified and can be monitored. By using these aggregate
LOORP files it is possible to construct a current antenna pattern that will yield a more accurate pattern for measured pattern
radials than the yearly recommended boat APM.

Having a definite path to making AlS patterns from multiple LOOP files is not really possible. There are many factors that
make every site a unique challenge. The scope of this document will be to outline some general techniques that should be
applicable to most cases.

General guidelines

In order to get the most out of the AIS data it is best to proceed with the following guidelines.

The Signal to Noise filters (Signal Level, Local SNR, I1IR SNR) should be considered as the rough refinements of all the
filters involved and should be used to remove only the worse data points and nothing more. A favored approach is to adjust
these filters so that they only begin to remove data. Once these filters are used in this manner move on to the other finer
tools to continue developing the antenna pattern.

After every adjustment click on the Pattern tab and see if any improvement has been made to the pattern data. In this
method one can see if the filtering is helping or not.

If the site has a traditional pattern installed try to create a pattern within one week of the AlS installation, this way a
benchmark pattern is established and the AIS Auto APM system can take over from there. Though it is not necessary to
have a standard pattern, using the traditional pattern as a starting point is very helpful.

Do not extend the pattern over land. Because the AIS pattern is being created from the local shipping traffic it may be
possible to get pattern points that would put a land path between the antenna and the ocean, use the limit sector filter to
avoid this as land path signals tend to give bad data. One exception to this is the long range SeaSonde but even then try
not to allow any land path greater than 1-2 km.

Example of Using CrossLoopPatterner to Create an AIS Pattern

First select the set of LOOP files to be used. Normally a week or more of data can be used for pattern making purposes.

1. Go to /Codar/SeaSonde/Data/AlS/LOOPs

2. Select the data set to be used. There is no limit on the number of LOOP files that can be used but the more LOOP
files implimented the slower CrossLoopPatternener will operate.

3. Open the files with /Codar/SeaSonde/Apps/Tools/CrossLoopPatterner.app
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Figure 8

Once this is done begin to apply the filters to remove the lesser quality signal hits from smaller, faster moving ships. Use
the Filter tab filters as the rougher over all data removal and the AIS Filters for finer improvements to the data.

Beginning with the Signal Level filter remove enough points to begin to see a clear pattern in the phases or at least to see

the phases from each cross loop distinctly. In this case the value decided upon is 11 dB.
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At this point click in the Pattern tab to see how the pattern has changed with the application of this filter.
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With the application of the Signal Level filter the lobes of cross loop 2 have begun to show a more distinctive characteristic.
Note, this result was arrived by changing the filter and checking the pattern with every step.

Proceed to the other S/N filters found in the AIS Filter. Use the Local SNR filter and IR SNR filters to remove the larger
noisier peaks seen in the amplitudes. Remember to check the pattern tab for improvement. Use only the minimal amount of
filtering as these are supposed to be rough refinements.
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As note, check the pattern as the filter values are modified.
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Check the coast line angles of the SeaSonde, use Limit Sector Filter to remove over land points.
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Figure 14

87



SeaSonde SSRS-100 Operator’s Manual

Use the Range width, Doppler width and Bragg Velocity filters to continue refinement of the antenna pattern
before check the Pattern tab for improvement with each change of the filters.
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Figure 16

At this point all relevant filters have been employed. Click the Pattern tab. User the Smoothing parameter to i
pattern. As noted in previous documentation 20 degrees should be the maximum amount of smoothing used.
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Click the Finish tab and save the pattern. The AIS APM generated pattern is now complete.
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Now that all the filters are in use one can use the smoothing filters in the Pattern tab. In this case we used 20 degrees in the
smoothing tab after careful examination,
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It is of note that one should not use more than 20 degrees of smoothing.

Troubleshooting

GPS Track files should be created every ten minutes and Loop Pattern files should be created once per day. If this is
not occurring, then there are several ways to try and determine the cause.

The easiest check is the AIS WebServer. Load localhost:8241/ in a browser window. All AlS position messages
should show, with the most recent messages at the top. If there are no messages then the antenna may not be

receiving signals properly, or the AIS Logger may not be running. It is possible for AIS messages to be infrequent in
areas with low ship traffic.

Output logs for all AIS related processes can be found in /Codar/SeaSonde/Logs/AlSLogs/. In the AlSTrackerStatus
log or AlSTrackerError log, a License Key Not Found error suggests that the SeaSonde USB Hardware Key is not
plugged into the computer properly, or does not include the AIS Suite license.
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Installation of Other SeaSonde Accessories

Extended Lightning Protection Unit

The SeaSonde Lightning Protection Kit (product code LT-E1) is an optional accessory that is compatible with all
SeaSonde models. It consists of an all-weather industrial enclosure containing an array of spark gap arrestors and
30’ (9 m) coaxial extension cables (three RG-58 & one RG-8). See photos below.

This kit is intended to be installed inline between the SeaSonde electronics and the Rx/Tx antenna(s). It provides no
protection for the antennas, only for the electronics chassis. The enclosure should be mounted upright and,
preferably, outside of the room/enclosure containing the electronics chassis. Four 1/4” diameter holes are available
for mounting screws.

Installation

e Pass the transmit and receive cables from the antennas through the open cable-hole of the lightning
protection kit enclosure.

e  Connect the transmit (or T/R) RG-8 cable to the N connector of the spark gap arrestor labelled TX ANT.
Similarly, connect the receive antenna RG-58 cables to the arrestors marked channels 1-3. You will connect
only cables 1 & 2 to the arrestors if you are using a T/R antenna.

Close and secure the box.
Connect the coaxial extension cables of the Lightning Protection Kit to the respective channels on the back
of the transmit and receive chassis channels.

e |MPORTANT: Grounding the enclosure.

e There is a small terminal on the outer side of the enclosure to the left of the cable hole as shown
below. Connect a heavy duty gauge#8 copper wire or strap (not included) to this terminal and
connect the other end to a proper electrical ground.

e  Proper electrical ground can be a metal stake driven into the soil or an existing ground system for a
local building/structure.

e Consult a local electrician if you have questions about the proper length of ground stake for local
soil conditions.
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Ground terminal aon
underside of enclosure

UPS

Activating Network “Smart” Feature on UPS Using PowerAlertTM Console

These instructions are for the Tripp Lite PowerAlert Smart OnlineTM model #SU1500RTXL2UA
(100V - 120V) or the equivalent 220V version model #SUINT1500RTXL2UA, with add-on Tripp
Lite SNMPWEBCARD UPS Remote Monitoring and control (via SNMP, Web, or Telnet).

1) Once the system is powered up use an IP Scanner to search for the UPS IP address.
The address will be connected to the MAC address that is found on the UPS back panel.

2) Open the PowerAlertConsoleV64 application found in the /Applications folder of the
SeaSonde computer.

3) The PowerAlert login dialog appears. Enter the IP indicated at the top of the window into
the Host dialog. The name and password will be the default login ‘localadmin’. When the
OK button becomes active click it.

4) The PowerAlert main page appears. This page will indicate the status for the utility
power, battery status and status of load output for the de- vices connected to the UPS.
Note the communication status is now indicating a green light denoting a secure
connection. For the purpos- es of this manual focus will be exclusively on the Actions
section of the PowerAlert app. It is encouraged the user read the online manual found in
the Help section of the PowerAlert app if interested how to ful- ly use this software. Click
on the Actions link.

5) The PowerAlert Actions page appears. This page allows the user to configure email
alerts and create other actions that will affect the be- havior of the UPS if certain
conditions arise. This manual will concen- trate on the Load Actions section, the user is
encouraged to read the Help section to setup email alerts or other actions. Click on the
Load Actions link found on the left side of the window.

6) The PowerAlert Load Actions page appears. This page allows the user to configure
commands and actions that will affect the behavior of the two loads used by the UPS.
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The UPS will now be set to turn off Load 1, as shown in the wiring diagram
aforementioned Load 1 powers the TX chassis which is the device that draws the most
power of the Sea- Sonde system. The UPS will be set to turn off the TX chassis in order
allow maximum up time for the SeaSonde during a brown out or black out of Utility
power. Click on the Name section as shown below and enter the name L10FF.

7) Follow the instructions indicated and click on the section next to the ac- tion name as
shown below.

8) The Action Configuration dialog will pop up. Carefully read the alert window. When
finished press the OK button to begin configuration of the L1OFF action.

9) Select the load 1 by clicking on the ‘1’ in the Select a load on Device 1 window. Note
when selected the red X next to the 1 turns into a green check mark.

10) Proceed by clicking on Device 1 in the Select trigger devices window at the bottom of the
dialog.

11) TheSelecteventstotriggerthisactiondialogappearsontherightof the popup window. There
are three sections of interest now in the window. The Load Action menu located in the
bottom selects the type of action to be done. There are three possible actions; On, Off
and cy- cle. Make sure the load action selected is the Off action. The load control delay
menu sets a time to delay the load action selected. The delay time will be set later on in
this manual. The Select events to trig- ger this action dialog is separated into two
columns. These columns are for Set events or Clear events. In this case the event
selection will be the Set event ‘OnBattery:1’ which indicates Device 1 (the UPS) is
running on battery power. Other events are detail in the help section.

12) Set the Load Control Delay to one minute as shown below. This will allow for the UPS to
remain in normal operation in case of a short time brown out power situation without
turning the TX chassis off. If the power remains off the chassis will shutdown.

13) Select the ‘OnBattery:1’ Set event from the Event(Set) column as shown below. Note the
Action is indicated in the text dialog at the top of the popup window as an ASCII
command.

14) Click the Save button at the bottom of the Actions Page now highlighted.

15) The Set Action is now saved.

16) A new action will now be added that will allow the UPS to turn power back on to Load 1
when utility power is restored. This is what is known as a Clear action. Begin by clicking
on the plus sign button at the bot- tom right of the window as indicated below.

17) In the name section enter the name L10n

18) The Action Configuration dialog will pop up. Set the Load Control De- lay to one minute
and the Load Action to On as shown below.

19) Select Device 1 in the Select trigger devices window as shown below.

20) In the Select events to trigger this action window, select the Clear event ‘On Utility
Power:1’. This will finish setting up the Clear Action and it will be shown at the top of the
popup window as an ASCIl com- mand as shown below.

21) Click the Save button at the bottom of the page. The Actions page will now indicate the
two saved load actions.

22) Configuration of the UPS is now complete. Click on the Log Out button highlighted at the
top right of the console window to log out of the PowerAlertConsoleV64 application.
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Environmental Control Enclosure

The SeaSonde Enclosure 36-B is a small, rugged closed-loop temperature-controlled enclosure
for containing the SeaSonde remote unit electronics. The small enclosure is just large enough
to fit the SeaSonde transmit and receiver chassis and mini-style computer, plus a UPS device
and another small piece of electronics. This enclosure is appropriate for both indoor and limited
outdoor use.

Tools required

e #2 Phillips Screwdriver (medium tip)
e 2 Small Bungee Ties (included)
e Velcro Ties (Optional)

Equipment required

SeaSonde ENC enclosure (fully assembled)

SeaSonde Receive Chassis w/Power & Antenna Cables!SeaSonde Transmit Chassis
w/Power & Antenna Cables!SeaSonde Rack Mount Bolts (qty: 8)

Computer (Mac Mini) w/ Power Cable (qty: 1)

Computer Peripherals (Monitor w/ Power Cable, Mouse, Key- board w/Extension Cord,
qty: 1 ea)

Power Adaptor Cables (qty: 5)

USB Cable (qty: 1)

UPS

Video Cable (qty: 1)

Ethernet Cables (qty: 3)

Router/Modem w/ Power Cable (qty: 1)

SeaSonde Cross Connect Cables (qty: 3)

Optional: AIS Receiver & Antenna Cable, USB Cable (qty: 1 ea)

Installing Enclosure Contents

1) Open the Enclosure doors to expose the three sliding trays. Note the front of the
enclosure will have the modem/MacMini tray to the rear.

2) Place SeaSonde receive chassis on the bottom tray.

3) Place SeaSonde transmit chassis on the tray above the receive chassis.

4) Place any UPS device on the floor of the enclosure beneath the receive chassis.
5) Push the trays back into the enclosure.
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6) Pull out the computer peripherals tray and place the monitor along with the keyboard
and mouse.

7) Use the provided bungee cables to secure the monitor as shown below.

8) Connect the peripheral cables and a keyboard extension cord to the keyboard USB
connector. [Note: Disconnect keyboard when not in use.]

9) Lean the monitor forward to put the peripheral tray into storage mode.

10) Secure the Chassis by bolting them to the side rails. The picture below shows the two
chassis bolted with a single bolt per side.

11) Install the Mac Mini and modem onto the computer/modem secure with velcro straps if
desired. Refer to the wiring diagram to install cables, note use the power cable adapters
provided to use the inline power strips provided. Please refer to the appendices for UPS
setup and cabling instructions.

Wiring Diagrams

The following section deals with the wiring of the typical enclosure contents including an
Uninterruptible Power Supply (UPS). UPS make and model shown in these examples is the
Tripp Lite PowerAlert SmartOnlineTM 110 V model # SU1500RTXL2UA or the equivalent 220 V
version model # SUIN- T1500RTXL2UA.

Here is the general diagram that will be used for the guide. Note the three sections detailed
below. The diagram assumes that all the peripherals, SeaSonde chassis and a UPS are
installed in the ENC36 enclosure. Note the Peltier coolers are built into the doors of the
enclosure.

At the time of this document creation, the UPS offered by CODAR Ocean Sensors is the Tripp
Lite SmartOnlineTM UPS. Diagrams in this document depict the back of the APC
SmartOnlineTM product.

1) Plug the two Peltier cooler power cords into the power strips with the rear Peltier cooler
power cord into the top inline power strip and the front Peltier cooler into Load 2 section
of the UPS (as shown below).

2) Plug the bottom inline power strip into Load 1 of the UPS. Plug the UPS to the top inline
power strip.

3) Plug the top inline power strip into outside power.

4) Plug the Mac Mini power cord into Load 2 of the UPS.

5) Plug the video cable into the Mac Mini and the monitor.

6) Plug the Ethernet cable into the modem/router and Mac Mini.

7) Plug the provided USB cable into the receive chassis and the Mac Mini.

8) Connect an Ethernet cable from the outside Internet wall outlet into the modem/router

primary Internet plug.
9) Connect the UPS into the modem/router with another Ethernet cable.
10) Plug the modem/router power cable into Load 2 of the UPS.
11) Plug the monitor power cable into the bottom inline
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12) Connect the TX and RX chassis using the three SeaSonde cross connect cables as
shown.

13) If AIS is installed, install the AIS antenna cable to the AIS receiver and USB from the
Mac Mini to the AIS receiver as shown below.

14) Plug in the RX (receive) chassis power cable into the bottom inline power strip.

15) Connect the GPS cable into the GPS antenna BNC connector on the RX chassis.

16) Connect the Loop 1 and Loop 2 antenna cables into the antenna loop 1 and antenna
Loop 2 BNC connectors on the RX chassis.

17) Connect the transmit antenna cable (or transmit/receive cable) to the TX chassis at the
Transmit Out to Antenna Type-N connector.

18) Plug in the TX chassis power cable into the bottom power strip.

External Hard Drive
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Routine Monitoring

via RadialWebServer Display

The SeaSonde’s RadialWebServer provides you with a means to remotely monitor its performance via a web
browser. This application is installed with SeaSonde Radial Suite Release 6 and Release 7. Remote monitoring is
limited to viewing and downloading the site’s status, configuration, spectra, diagnostic, wave, and radial data.

A browser client will need the site's URL or IP address and Radial\WWebServer user name and password to gain
access.

e To gain remote web browser access the site must be configured with a static IP or a DNS service to allow
the site to be visible on the Internet.

e You also need to specify the port number to use. The default Codar port is set to 8240. Using the default port
is recommended. [Note:Please read the RadialWebserver-Admin.pdf document included with the Release 6
and Release 7 installer, before you customize with a non-default port number.

e To access the remote site, enter the site’s static IP address or the DNS URL and the port number. Example:
hitp://x.x.x.x:8240, where x.x.x.x is the site’s static IP address.

e Test the RadialWebServer on the site. Open Safari and enter "http://localhost:8240" (use your selected port
number, if not 8240)

e The login page shown below is displayed when accessed using Safari.
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For more isformation, please sl CODAR Ocean Sendors

e Enter the RadialWebServer Admin user name and password. A successful login will result in showing the
status of the site. Don't be concerned about the alerts, yet, if you are still setting up your site.
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Click on the Admin link in the upper right corner of the window. This will allow you to view and enter more user
accounts to access the site. Click on the New user to add more accounts. If you want CODAR support staff to be able
to access your site, create an account for them.
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Lfst!ng users

EnkaInde Sum E] Desrey

e User name and password are case sensitive.
e Three kinds of authorizations can be set up for a user:
e Site Management: administrative user who has permission to add/remove/edit users.
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e View Data: user who can see Status, Details, Radials, Waves, Spectra, Diags, Logs, and Refresh
Settings. This user cannot view or edit the other users and will not see the Admin link.

e View Status: user limited to Status, Details, and Refresh Settings. Clicking the other views will
jump to the login view. This user also cannot view or edit the other users and will not see the Admin
link.

Note: You will be unable to remove the first Admin user. If you try,you will see a “Cannot delete admin user.”
message. You can remove all users by reinstalling the RadialWebServer; the installer has an option to rebuild the
user account database and will create a new first admin user as explained in the beginning.

The above steps should be enough to set up the Radial Web Server

If there are any problems with the RadialWebServer, use a text editor or Console to open the log files
RadialWebError.log and RadialWebStatus.log located in /Codar/SeaSonde/Logs/ These are included in
SeaSondeReports file which should be sent to support@codar.com.

For any additional information about RadialWebServer, please read the RadialWebServer Admin document.

Navigating the RadialWebServer interface

Open your browser and enter “x.x.x.x:port’ where x.x.x.x is the static ip address of the site and :port is the
port number used to install the RadialWebServer (the default is :8240). If using at the Remote Unit
computer, you can enter “http://localhost:port” to open the RadialWebServer page.

Login Page will appear as in the image below.

SeaSonde Radial Site CRVT
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For mom information, please visit CO0MN Dooas Sarmon

Enter the username and password.

If login details are correct, the Status View page will open.

The 4 letter site code is displayed next to the SeaSonde Remote Unit banner.

On the right are Admin and Sign Out links. Below these 2 links, the date and time at the site are displayed.
Vertical menu list of views is on the left.
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SeaSonde Radial Site SASO
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The different views are as follows:

Status :Site’s current status

Details :More detailed status about the site’s configuration, status, hardware, and data.
Radials :Plot any radial within last year on the site.

Waves :Plot any wave data within last year on the site.

Spectra :Plot any spectra within last year on the site.

Diags :Plot the hardware and radial diagnostic files.

Logs :View critical site logs and create/download a SeaSondeReport file

Archives :Download archived data from the site

Settings :Change the refresh interval and setup the alert email service.
Status view gives a quick look of whether the site is working well or not.
e Alerts section lists any problems with the site. IF no problems exist, then “Nothing to Report”
message is shown.

e “Site XXXX” section shows basic information about the site like name, location and other settings.
Clicking on the co-ordinates opens a google map of the site’s location in a new window.
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e The Radials section shows thumbnails of the last radial vectors for both Measured and Ideal
patterns plus a 25hr averaged radial for the site. Clicking on the thumbnail will open a full size pot.

e The Spectra section shows the last CSS and CSQ cross spectra power maps. Clicking on the
thumbnail will open a full size plot. Carefully look at the radials and spectra plots can tell you how
well the site is operating.

The Details View shows sections with detailed information about the Site, Alerts, Receiver, Transmitter, Data Files,
Processor, and SeaSonde Applications running. Some of the useful information here is receiver firmware, hardware
temperature, transmit power, disk space available, and applications’ version numbers.
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The Radials View allows you to plot and download radials up to one year ago on the site.

The first section allows selection of the radials to plot and/or download.
e The months during which the radial data is available, are highlighted with blue and an underline.
Click on the blue text to select the month.
This will display the corresponding month’s calendar below the selection.
The days with at least one radial file are highlighted in blue with an underline.
e To the right of the calendar is the Control Time bar with hours and minutes pop-up menus. Select
the hour and minute to display the corresponding radial.
Use the Step arrows to step back or forward in time to plot each existing radial.
Click on “Measured” or “Ideal” links in the Type bar to display corresponding radials. If the selected
type does not exist, you will get a “No Matching Radials” instead of a plot below.
The Latest: Auto Off control, if set to Auto, will automatically show the latest radial.
The section below this is the Radial Plot section,which displays the radial image

plot. You can drag and drop this image to the desktop or Right Click and select
“Save As” to save the image.

e Download section is at the bottom. It shows the link to download the selected radial.
e The small white triangles next to the section titles “Radials” and “Radial
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The Waves View can plot wave data up to one year ago on the site.

Select the start time to plot using the calendar as in the Radial view.

Time Span pop-up menu allows to set the time span of the plot.

The Latest control when set to auto will periodically refresh the page with the latest wave data.
The Wave plot section contains eight plots. Four plots for range cell 3 of wave height, wave period,
wave direction, and wind direction followed by four plots each containing range cells 2, 3, 4 & 5 of
wave height, wave period, wave direction, and wind direction.

e The Download section shows one or two waves files for the current time. Since Wave files are
monthly, the current month and the previous month both might be shown here. Clicking on the link
will download the selected wave file.
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The Spectra View can plot spectra data up to one year ago on the site.

Selects the spectra time to plot in the Cross Spectra section.

e Select CSS or CSQ in the Type control to switch between the averaged CSS spectra and the more
raw CSQ spectra.

e The first plot is the power map which shows the power returned as color intensity across all doppler
and range cells for the three cross loop antennas.

e The second plot section is a single range slice of power versus doppler. Use the slider and arrow
control to select the range cell to look at.

e The download section allows to download a reduced cross spectra file. is a special variation of the
standard cross spectra files which is compressed about 3:1. The utility SpectraShortener can
expand this file to a standard cross spectra format.
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The Diags View can plot the diagnostics history of the hardware and radial status diagnostic logs.

Use the Control section to set the start time and the time span to plot.
Next is a radial diagnostic section containing 10 different plots followed by a hardware section

containing 7 plots.
e The Download section shows one to four diagnostics files for the current time.
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The Logs View shows a list of system and SeaSonde logs for the site and also allows the web user to enter
notes into a site log and generate /download a SeaSonde Report file.

e Enter any notes, logs in the Site Log Entry section and click the Submit button.

e This entry will be time stamped and tagged with your RadialWebServer name and appended to the
Site_ XXXX.log file where XXXX is the site code.

Click on any log file in the Log Files section to view the log file in the next section.

e The Diagnostic Report section allows you to generate and download a SeaSonde Report file which
you can send to CODAR support personnel for diagnosing problems. Customers are recommended
to send this file to CODAR support whenever contacting for any issue.

e Click the Generate button to start downloading a RPT_XXXX_yyyymmdd_hhmm_web.zip file. The
file size can vary between 2MB to 5MB, hence can take couple of minutes to download
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The Settings View is used to control settings for the RadialWWebServer and the email alerts. The “System Settings”
section will only be available to admin users.

e  Currently, the only configurable setting available is the Web Page Refresh Interval. This time sets
how often the browser requests new data from the site.

e The refresh setting applies to the Status, Detail and any other views using Latest: Auto mode.

Setting up Email Alerts

The Settings View in the RadialWebServer interface allows to set up email alerts.

e RadialSiteReporter tool on the remote unit computer generates the site alerts and optionally emails
them.

Read RadialSiteReporter document for detailed information on its function.
e  Click on Alert Mail Configuration link to enter the email address to whom the email alerts should be
mailed. (This feature is available only to admin user account).
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Status Web Settings for User “s
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Waves
Spectra
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System Settings
Alert Mail Configuration

Logs
Settings

e Click on the Create New link to add the email address to the list. Remove link will delete the email
address from the list. Edit link will enable editing the settings for the particular email address in the
list.

e Enter one or more email addresses separated by comma.

Note: Please, do not abuse this feature; do NOT send alert emails to an unsolicited address.

New Emalil

Addresses:

Enabled: ™

Send Alert Changes: ™
Send Pariodic Report; ¥
Schedule: | weey §]

{ Ereate

Back

Select the Enabled checkbox to activate that email address(es) to receive alerts.
Select the Send Alert Changes checkbox to send an email to addresses whenever an alert is
tripped or cleared.

e Select the Send Periodic Report checkbox to send out the Site info plus the Alert logs periodically
selected by the Schedule: popup. (Currently, this feature is not available.)

Below is an example of the email alert:

From: codar@SeaSondeSite-XXXX.local

Date: March 30, 2009 12:14:24 AM PDT

Subject: [SeaSonde] TEST Alerts [TxNotFound,CSSNoBragg,CSQNoBragg]
To: you@yourisp.com

2009-03-26 13:14 UTC-7 Failure: Transmitter Not Found.
2009-03-26 13:14 UTC-7 Failure: CSS has No Bragg.

2009-03-26 13:14 UTC-7 Failure: CSQ has No Bragg.
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2009-03-26 13:14 UTC-7 Failure: Radial Contains No Vectors.
2009-03-27 18:53 UTC-7 Failure: Radial is Not Up-to-Date.
2009-03-30 00:14 UTC-7 Success: Computer is Running

via Timbuktu Pro (Screen Sharing)

Timbuktu Pro is a screen sharing and data transfer application for PC and Macintosh computers. It is installed by
default on computers shipped with SeaSondes or spare units ordered from CODAR. It is a valuable tool for viewing
real time data displays on remote SeaSonde computers.

Controlling the Screen of the Remote Unit Computer

Locate the Timbuktu Pro menu found in the upper right hand portion of the Desktop menu bar (Macintosh) or on the
widget tray (Windows) and select the Open Timbuktu Pro menu item, this will open/activate the Timbuktu Pro
program.

O % %7 % MonFebB 21:37.32 Q
£J Timbuktu Info

[} Admit Temporary Users. ..
& TCP/IP Incoming Access
% Answer Dial Direct Calls
™ Disconnect Current Users
&3 Disconnect codar [Secure]
a1 Switch codar to Observe [Secure]

B Show Activity Log
(1] Clear Recent Users

Go to the File menu on the left side of the menu bar and select the New Connection menu item:

& Timbuktu Edit Setup Service

New Connection [ %N
New Address Book...
Open...

Personal Address Book

Close W
Close All LEW

=0

In the New Connection window, select the Internet tab bar item as shown below and enter the IP address of the
SeaSonde Remote Unit computer.
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Next, click on the Service menu bar item. Select the Control from the drop down menu:

L Fxchange Control W

i} Exchange X
= Control

[/ Observe

[ Chat THT

{1 Notify THEA

& Intercom NHGC

4 Invite Y

@) Profile CHP
Skype Cal AIEY
Skype Chat

id Save in Address Book

Dial Direct
Activate Modem

# Install Timbuktu 3l
A ’ |

A Control Session Login Panel will appear:

Control kona.seasonde.com as:

() Guest
| Ak for Permission
(| Registered User
{*) Registered User (Secure)

Name: |_

Password || Add to Keychain
2

Cancel

Select either the Registered User or Registered User (Secure), enter in the Name and Password of the account and
click OK.

Note: Consult SeaSonde Support if you do not know account login information
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The Remote Screen Control window should appear. This will allow you to interact with the computer over the internet
as if you were physically in front of the computer screen:

B
=
e
-
2

Transferring Data to/from the Remote Unit computer

In order to transfer files, an Exchange Session must be activated. Click on the Service Menu at the top of the
Desktop. Select the Exchange Menu Item.

Exchange Control W

m Exchange

Service

a3 Control wRC
Observe T
[ Chat TET
[T} Motify A
d Intercom TEG
& Invite pe 40
@ Profile THP
Wy Skype La =Y

Skyp £

Dial Direct
Activate Modem

& Install Timbuktu 380

This will bring up a Exchange Session Login Dialog.

Select either the Registered User or Registered User (Secure) account login and enter in the Name and Password
associated with the account. Consult SeaSonde Support if you do not know the account login information.

The Exchange Session window will appear. This will allow to transfer files and folders to and from the remote site
computer.
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The Exchange Session window has two main areas: the file space of the Remote Site Computer and the Local
Computer. These areas can be used to navigate both remote and local file systems.
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The following example will demonstrate how to navigate to and move a file from the Remote Site Computer to the
Local Computer. First, navigate to the target folder on the Local Computer (left side) by clicking on folder or volume
icons appearing in the Local Computer File Space to move down the folder tree or by using the drop down menu for
the current folder to move up the folder tree:

AN ] Exchange Files with koaa [Secuie]
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e [ TOTL KA 2002 DE 2% L1600 v T
: [ TOTL_KHdA_2012_01_25_1700.nm TEK
Baleosh | [ TOTL_KOHA, 2002 01 25, LAOD, v S
| O TOTL_KHdA_2002_00_25_ 15900 tuw K
| [ TOTL_KOMA_201Z_01_25_20H0. 1w TIK
ID TOTL_KOMA 201 ul_:"_‘i: 2000 1w :l'ﬂ :
T

Next, navigate to the source folder in the Remote Site Computer (right side) and select a file to be transferred. The
file will highlight in blue:
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AaNn 2} Exchangs Files with koo [Secure|
LianTwilRdird hank
= il i H = CodarData & 9 Teaali E
1 Bam £10.1 ulh'll-‘lﬂl_ HO stmema = Data 1 fiu.l'l.'lllhh_
| O Aeretne Crampanad [ TOTL KOKAS S Sutoade N 7K
[ TOTL_KOKA S o o " 74K
Ermiadurrd lpmomorond oo W oK
[ ToTL_KOwa_3 Bo - oK
[ pmm e TZK
[==spy=e] | @ TOTL_KOWA_Z2012 01 75 1500 0w TBE
o [3 TOTL_KORA_FI12_01_35_ 1600 e TBE
[} TOTL_KOKA_T012_01_1%_1700.bwv TBE
Bebiesh = [} TOTL_KOKA_F012_01_35_ 1800 0y 59K
[} TOTL_KOhA_FO12_01 25 1900.ne 71
[} TOTL_KORA_T012_00_1%_ 1000, by 7oK,
[} TOTL_KOHA 201200 2% 210000 LY
T
Click Copy. A File Transfer Panel will appear with a progress bar.
a0 ¢} Exchangs Status
Fross kg ?
File  TOTL_KONA_Z012_01_28_2200:uv (45 of 3021
- D - : } (o
Remaining:  Abost 4 minues (12.9 M)
Throughgut: 1.1 ME per secend
The transferred file will appear on the Local File Space when the transfer is complete:
ann ] Eschange Files with kona [secure]
LigaTewthdmi [
= Desktap = = CodiniDiaka ) Tatads
2 itwems 410 8 avaitaisle 300 e 3 CE awuilable
‘L Archiee ) Corigeias |0y TOTL KOMA_2012_01_25_1000.1us 71K |
. §

M TOTL_KONA_2013_01_F5_ 1160 8y T e Fosan o | OV TETL RORA 20102 015 110010 K
| O TOTL_KOMA_I0K2_01_25_1200.tuv [E
| [ TOTL_KOMA_2012_01_25_1300 1w oK

: | [ TOTL KOMA,_2002_01_25_L400.1uw K
= L | O TOTLROMA_ 2012 01_2% 1500 Ll
[Ty | [ TOTL_KONA_2012_01_25_1600 1w 7oK
| {1 TOTL KONA, 2002 01_25_1700.0n TiK
Mk 22 | [ TOTLKOMA_ 2002 0125 1800 fur am
| [ TOTLKONA_2012_01_25_L900.1uv TS
| [ TOTL_KOMA,_2012_01_25_2000ruw R
;urr:m ROMA J00E 01 2% ¥ 108 e oK
T

Viewing Vector Data with SeaDisplay

SeaDisplay is CODAR'’s surface current data visualization tool. It can be used to plot radial and combined surface
currents as well as generate radial distributions, plot standard deviations and generate current vector animations.

Opening SeaDisplay
Click on the SeaDisplay Icon found in the Dock. Or SeaSonde/Apps/Viewers.

SeaDisplay

= B

b ez

A map window showing the default map area should appear.
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The task bar, located located above the map area on the left side, contains icons that control the most important
functions. .

The velocity color scale is show along the right side of the map window.

Task Bar Icons

Display a File Open dialog and point to the Radial Files folder.
When a file is selected, SeaDisplay will automatically load all
matching radial files in the same folder.

File Open

p— Plot the previous or next sequential radial file in the same
folder.

Prev Next

This is the Radial Distribution Plot Icon. Clicking on this icon
will allow the user to see the radial density plots of the radials in
the Radial Files folder.

Radial Distribution
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Create a PNG image file of the current window display.

Save Image

Create a Quicktime movie of all the radial data files contained in
the current folder. The movie file will be written to the Desktop
of the user's Macintosh computer.

Create Movie
Open the SeaDisplaySetup program to modify the current

SeaDisplay site map. Please refer to Creating Site Map found
in Optional Configuration Tasks.

Opens the Spectra Plotter Map application.

Spectra Plotter Map
Plotting Radial Files
Click on File Open and select a radial file from the Choose a File Lo e v Chrs
dialog. Dragging a file and dropping onto the SDisplay icon will also e e -
. . . . . . TAREITEY — —— — ]
open a file. Double-clicking a file will also open in SDisplay. - T —— it
oy Apieata B o OT0E_200_ 60 _1%_ L0 (NFLELF]
15 otar W oL OTEC_POLE 81_19_ A0 e LW
5 Sratongr B s OTIE_I01E 81 1%, N0 e Ll
& : In.:_:.l:u_mu_w_a:_l.m: |:¢::u
£ menms 3 oI e e
: : . - . 2 Ape B i ORI 61,25, 5000 iRl
The selected file will be plotted and all matching files will be loaded B o 2 10, OTIC 1612 0113, M tisias
[ - TR A TR AL ] o Ja,
into memory. £ Dag B mow OTRE_PELE 81_EY 2300 v L
nl- B e TR 30X SN i e L%
W s AR
By clicking Prev or Next the user can step through sequential radial e ' o | g
files one at a time.

VL L b

o
FETY T T LI

b il bt

To create a radial distribution, click Radial Distribution in the s
task bar.
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This may take a little time, depending on the size of the radial file list.

When the computation is complete, a radial distribution plot will be displayed on the map.

Note: the velocity scale on the right is now replaced with a Vector density scale.

Viewing Spectra

Spectra Plotter Map is a visualization tool that allows for
the plotting of spectra data. This software also allows for
analysis of signal to noise ratio, signal noise floors,
maximum amplitudes and phases with regards to
physical range and doppler range.

Plotting Cross Spectra Files

There are three primary types of spectra files that
Spectra Plotter Map can plot and analyze:

CSQ files - These files are created after the first FFT
process and are considered the lowest level cross
spectra files

CSS files - These are merged sets of CSQ files that are

nn B Elm EE_JETIAT N|_BO00 e

PR

mmn

t

created by the CSPro program. These are the files that are used by the radial processing tools to extract radial

vector files.

CSAfiles - These files are averages of CSS file sets over an hour.
This document will cover opening and analyzing a CSS file using Spectra Plotter Map. The other file types a can be

similarly opened and used in the same fashion.

To open a CSS file mouse to the folder containing Spectra data. Normally the user can find the CSS files either in the

following folders:
/Codar/SeaSonde/Data/Spectra/SpectraProcessed/
/Codar/SeaSonde/Data/Spectra/SpectraToProcess/
or alternatively in the Archives folder:
/Codar/SeaSonde/Archives/Spectra/

ann L SpectraProcessed

Law] £ - EEI BE I

FAVDRITES  hame a  Date Mosfied Site Kin
B beskap % Feb 4, 2012 11:16 P e

B Cds_TEST_12 02 04 2320084 Feb 4, 2012 11:51 74 490 KE G
¥y Applichtions B Cus_TIST_12_02_04_25B0.csd Fab 4, 2012 11:60 435 KE G
[ Codar B OS5 TEST 13 07 _04_2540.c84 Feb 4, 2011 1149 MW 656 K (£
B Seasonde B C55_TEST_12 07 04 3350054 Fobs 5, 2012 12203 AN BIEKR O
B Conligs B O35 TEST 13 07 05_000.csd Fab S, 20013 12:12 AM 6I6KE  Cm
B C55_TEST_12_07_05_0010.c54 Feb 5, 2012 1221 AM BIGEKE  Cm

I Archhvey B Cos TEST_12.02 05 0020.c54 Falr 5, 20012 12:29 AM GIGKE  Cio
3 Apps B 55 TEST_12.07 05 DO30.c5d el 5, 2012 12:42 AM GIEKE  Cio
s oua B £33 TEST_12_ 07 05_00&0.csd Feb 5, 2012 12:50 AM BIEKE  Cm
B B Cu5_TEST_12.0Z_05_0050.c34 Feb 5, 2012 12:58 AM BI6KE G
- B Ca5 TEST 1202 0% 0100034 Felr 5, 2012 1:12 AM LELT S
i Logs B O TEST_12.07 05 0110.084 Febi 3, 2012 1:70 AM G55 KE  Cro
[ Radials B co8_TEST_12 02 05 0120.654 Vb 5, 2012 1:28 AN G5B KE  Cio
[ Spectra !{iﬁ_lf's'l_lﬂ_u{_ui-_ljllmul Fab 5, 2012 141 AN B36 KR (<]
= B 55 TEST_12_02_05_0140.c88 Fab 5, 2012 1.50 AM 5I6KE  Cro
L Waves = L ' S

AR ) Codaburs = [ Cx = g% » [g0u = g% = [ pectrabrocevued + [ C34 TEST 12 80 04 3110034

Spectra Processed Folder
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Simply drag and drop a CSS file onto the SpectraPlotterMap Icon on the Dock found in the Desktop.

SpectraPlotterMap

The SpectraPlotterMap program opens with four main dialogs; the SpectraColorMap, the Range Slice Map, the

Doppler Slice and the CSS Informational Display dialog. A brief description of these main dialog follows:
L = et vk

i e £_EIIH. o4

First Order
Limit Lines

Spectra Color Map

This dialog displays signal intensity via a color "temperature" display, cooler colors indicate lower signal or noise
levels while warmer colors indicate greater intensities. Normally the dialog shows the signal and noise levels on all
three antenna channels as indicated on the left hand side of the dialog. The horizontal axes are normally displayed
as Doppler cells from the center or DC region of the graph going out in positive and negative Doppler directions and
physical range cells distances for the vertical axes. These axes can be changed to translate the distular range and
Doppler cell range to frequency and kilometer units ( or other combinations) by mousing to the Graph menu and

checking the options desired.
_Map (TN Window Help

4 Toggle Range Units #R |
¥ Range Cells
Range Kilometers
Range Miles
Range Nautical Miles

Toggle Doppler Units ¥D
v Doppler Bins From DC

Doppler Bins Index

Doppler Radial Velocity cm/s

Doppler Target Velocity m/s

Doppler Target Velocity mph

Doppler Hz

+ Spread Antennas £0dB  O#S

Graph Menu
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AN & Range Sler

2 O 1 R

Indridisal Anfennia Signal |
Strengih

Range Slice Dialog

The Range Slice Map Dialog displays the signal strength of an individual range cell. This is in contrast to the the
spectra color map that shows signal simultaneously for all range cells and frequency shift. Note the three antenna
channels are displayed on this dialog are biased to be 20 dB apart with regards to each channel so that the spectra
can be seen clearer rather then displaying the three channels directly on top of each other. The horizontal and
vertical axes of this dialog will change along with the Spectra Color Map by changing options in the Graph Menu
detailed above.

e 00 4 Doppler Slice
C33_DEMD_09_03_16_071S os4

-0 T

_gn|_|A1-00d8 —

-100 || A3-40dF —

-110
~=120

=130 :
140 I
M o ,"‘v"' i,

— "

g 150 s & o I L ——
@ ~160 - s e Lo |

-170 -

10T U FL_ 5 — <o

e - . ~ T T -
-1%0 | e o o i — et P
~
-200
1 4 5 12 16 20 24 28 31
Range Cell
Spectra for Deoppler Cell O

Doppler Slice Plot

The Doppler slice map shows the signal power in terms of decibel per meter for each doppler cell with regards to
range. This dialog with change as the focus is moved along the Range Slice Map Dialog or the Spectra Map via the
arrow keys on the keyboard.

Focus Indicator on the Range Slice Map
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e 0N @ CSS_DEMO_09_03_16_0715.cs4
CSS_DEMO_A9_@3_16_BA715.c54
File VYalid Selected Range 1 {0.360 km) (B.186 mi)
CS Yersion,Kind 4,2 Selected Doppler 672  +162{0C)
Site DEMOD Current Yelocity -18.2 cm/s
Date B3-16-2089 @7:15:848 Doppler Yelocity +2.26 m/=s
Coverage S minutes Left Bragg 342 -169.3{0C F0Q [-1,-1]
Center Freg 42.008080 MHz  Right Bragg 680 +169.3¢0C» FO [511,511]
Bandwidth -499 ,877299 kHz SH1,HF1 +25.2dE , 2
Sweep Rate 4 . B88888 Hz SH2,HF2 +34.3dB
Range Cells 1 to 31 SH3,HF3 +32.
Doppler Cells 1824 A1 -117.1dBm _,
A3 Heg. Flagged 164 cells A2 -189.8dEm ,

A3 -182.9dBm ,

A13 -118.2dB,
A23 -187.6dE, B9
A1Z2 -114.1dB, 25.4% : +8.9
Phase Factor A12,A23
Ampl. Factor A12,A23 2.

ol fux
fraf [ [

[
=

oo

Cross Spectra MetaData

The Informational Dialog displays relevant spectral information for a specific range and Doppler bin. As the focus
indicator is played around in range and doppler cells the dialog entries will change. Center frequency, bandwidth,

FFT length and other transmit information normally found in SeaSonde Controller setting will also be recorded in blue
text.

Viewing Diagnostics

This section describes how to use DiagDisplay to perform routine monitoring of radial data collection and SeaSonde
hardware operation. It is a valuable tool for troubleshooting of most problems.

About DiagDisplay

DiagDisplay is an application that is used to plot different SeaSonde radial and hardware data parameters from the
diagnostic files, on a graphical display to evaluate/diagnose the radial data and the SeaSonde hardware operation.
The diagnostic files (with the names beginning with “STAT_") are located in /Codar/SeaSonde/Data/Diagnostics. Two
types of diagnostic files are produced weekly on Sundays with the name STAT_XXXX_YYYY_MM_DD.EXT, where
XXXX is four character site code and “.EXT” is the extension of the file. “.EXT” is .rdt for radial diagnostic files and
.hdt for hardware diagnostic files. DiagDisplay can be used to plot several weeks or months of diagnostic files at a
time.

Opening Diagnostic Files

The DiagDisplay application is located in /Codar/SeaSonde/Data/Apps/Viewers. It can also be found in the Dock on
a factory-installed SeaSonde computer.

LA

DiagDisplay Icon

You can monitor different parameters like Radial range, Radial vector count, Noise Floors, Signal To Noise Ratio,
temperatures inside the SeaSonde Transmitter and Receiver chassis, some common voltages of the equipments,
and so on, using DiagDisplay.
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It is a good practice to plot the diagnostic files (“STAT_") weekly or bi-weekly to check the different radial and
hardware parameters.

Click the DiagDisplay icon on the Dock.
e The Adjuster Dialog and the Diagnostic History Plot window will open.
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Diagnostic History Plot and the Adjuster Dialog

Choose File > Open. Drag and drop method or double-click will also open a file.
Select the “STAT_" diagnostic files and click on the “Open” button to open files.
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el BT 2] 0
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File Menu Open

e By default it will plot one of the sets of parameters of the Diagnostic Files on the Diagnostic History Plot.
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Diagnostic Files plotted on the Graph

e Quick Plots pane in the Adjuster Dialog is used for quick plotting of a default set of related parameters
simultaneously, like Noise Floors, Signal to Noise Ratios, Phases,etc.

e Select “Custom” checkbox to plot parameters from different sets together.

Custom Plots

Maintenance Check and Troubleshooting

The example below shows how you can use DiagDisplay for maintenance check of normal operation of radial data
collection and SeaSonde hardware operation. This example specifically covers an instance, when a client observed a
sudden reduction in radial range during their regular maintenance check. This example shows how DiagDisplay can
be used in such cases to try to find out the suspected reason of problem. There can be more than one reason leading
to the same problem. This example covers one of the many reasons leading to the same problem.

STAT_FRID_ 2008 03_30.hadt [ Mo Sl Adjuster
S FRID Tiema iy
10 100 T . T ] ——
S2o08-04-03 00:00 = 1 weak o)
8. = 80 400 | Cluich Plats et A @8 Right
- i
s = [# Custom ™ view | Moise Floar Al B
() - .- {1 Amplinudes - T o]
ol L aaf Sz e = sl il ~180dem Flref (3] 20d8m ¥ Div
5 " cren || ) Phases
3 2 {1 Signal to Nolse Vet A #2 (Canners
¥ &l o a0l -id i~ m—
- s | ONotse Hoors | il vy [ Signal To Noise Al T3]
¢ |B |1 L} Range . = F =
~ 2[5 2af* 80 | () Temperatures + OdE :]“"'T - 2048 '!-ll)nr
." h II'DH“ES Wert A &3 (Left)
a a 11 1" et e ) Ts Vohage -
< - T sl )T Power ¥ View E‘.‘.’f‘f[iiﬁ_—_‘_
'_"‘ Auntima o T!".tl' ey :ll:h'r

Daas Saasi 2008-03- 30 S0.080 15 2004-04-15 2020 /di

e Select the “Range” checkbox to plot the Radial Max Range, Radial Vector Count and Radial Average
Velocity simultaneously.

STAT Smr2 300809 28 hdt (AN Addjuater
=i B Teee: Anis
100 100, 1 - S
sl 2008-10-17 0000 | [ I.murrl.ha
@ 80 iE i || Qv Mok Wit A 1 [Right)
B : z (L} Customn ¥ view | Radial Max. Range [
£ o - () Amplitudes < —
G &0 ool 2 en = ok lrer (220 i
: £ B G m *{Ra okm  ={Div
= , s I (O Sigmal 1o Nois®  ven s 02 (Cented
oS = = (7 Modse Floors
7 - Rtk | (@) Range
: o L& et () Temperatures
e Rx IfDﬂﬂ.ﬂEl Wt Ao @) [Left)
0. -5 | H B A R T ) Tx ¥okuge . - . =
~F = T — ks O T : M view | Radial Ave. Velacity X
) Runtime ! demis T".lf *l 20omis Tll}w
Baas Sanny D0E-09-28 5558 1= 20048-12-04 Ba k6 A = -

Plotting Radial Range Parameters
e Depending on your site’s operating frequency and settings, confirm if the radial max range and the radial

vector count seem reasonable.
o \erify if there is any period of time, when the range and/or vector count decreases.
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Select different set of parameters from the Quick Plots section to plot on the graph and confirm if everything
is working reasonably well.

Sudden reduction in Range

The Radial Vector Count and Radial Max Range looked reasonable till Wednesday 11/19. The radial range
and vector count suddenly dropped to zero on 11/19.
So, you can plot other parameters to find out the cause of range reduction.

STAT Semr2_2008_00_28 hdt Lo i) Adjuster
S| S Tima Aoy
100 100 —
“z008-11-14 0000 W )1 wee =)
' BO 150 _. BD Cpsick Mati Wert Axig &1 (Righa)
=, = L Custom ¥ view | Radial Max Range 2]
g ot B ) Amalinedes - e e "
L e :;}: H 1 A Fﬁaw:s - Okm et [2l[20km =0k
7 ] ) 5gral to Nolbl  yiery Amia #2 [Cenmerp
& dr = - &
- = IE‘l Mokss Floors ¥ \iew | Radial Vector Count 24
] B Range Aeerens el e -
- i Temperatures | [} -500 laer lleooe  =low
o -
= Fix Voltages Vet Awia &1 [Lefel
i { ) Tu Voltage
L riom | - . =
T s # View | Radial Ave. Velocity %
) Runtime sooemts  I=lRef (3] 20emis =l Div
Data Spaet J008-04-74 0000 1o 700K-13-04 0430 &

e  Select “Tx Power” checkbox. This will plot Transmitter Forward power, Reflected power and the Transmit
Trip parameters.
e Make sure that your site’s forward/reflected power readings are reasonable depending on your settings.
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Power Plot

The plot shows that the forward power was reasonable till Wed. 19 and then suddenly drops to zero.

This shows that the Transmitter is not transmitting any output power. It can be due to several reasons like
tripped transmitter, fallen antenna, cable cut, bad transmit power supply, bad transmit amplifier or any other
non-working module in the Transmit or Receive chassis.

Since, there is no forward power, there is no radial coverage.

The “Transmit Watch Trip” graph shows that the transmitter was not tripped at the time of failure. The default
value is “0”, the value rises to more than 1 when the TX gets tripped. So in this case, there is some other
reason.

Plot other parameters to try to find the reason for no forward power.

Select “Noise Floors” checkbox. Check the noise floors on all three channels.
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STAT Smr2_2008_0% 28 hdt
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Rise in Noise Floors

The noise floors suddenly increased around Wed 19. This can be due to several reasons like sudden increase in the
environmental noise or some internal hardware failure or due to bad antenna.

e Select “Signal To Noise” checkbox. Check the signal-to-noise ratios on all three channels.

A.0 STAT Smr2_H08_09_28.hdt A Adjuster
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Drop in Signal-to-Noise Ratios

The Signal-to-Noise Ratios on all the three channels dropped to almost zero, as there was no output power after Wed
19.

e  Select “Temperatures” checkbox. Make sure that all the temperatures look reasonable.
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Temperatures Plot
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The transmitter chassis temperature was reasonable till Wed 19, but after that it went very high. This can be either
due to the very high surrounding atmospheric temperature or very high temperature generated inside the chassis due
to some hardware component failure.
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Transmitter Chassis Temperature Rise

You can plot TX and RX voltages to confirm, if the common voltage readings inside the chassis are correct.

e Select “RX voltages” checkbox.
Confirm, if the Receiver +5V and +12V readings are correct. (Receiver DC supply reading is only for
systems with DC supply).

e If both the +5V or +12V supply reading are correct, it means there is most likely no failure in RX chassis
components.

e [f any of the supply readings is in-correct, then it means there is a hardware failure of one or more
components inside the RX chassis.
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RX voltage readings

e Select “TX voltage” checkbox.
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e On Wed. 11/19, the TX power fell to zero, TX chassis temperature rose to a very high value and the
Transmitter Amplifier supply dropped from its normal 24/28V value to a lower value.
e Un-check the “View” checkboxes with Transmitter Chassis and Transmitter Forward fields.
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This means that there may be some problem with the Transmitter amplifier power supply.

Hence client was suggested to make a site visit and measure the Transmitter power supply voltage and few

other voltage readings in the TX chassis.
e Finally, after all measurements, it was clear that there was some problem with the amplifier which was

pulling down the Supply voltage.
e In this way, you can use DiagDisplay, to get an idea about the suspected reason for any failure in hardware

operation or irregular collection of radial data.

Data Management

This section describes how to confirm that the Archivalist application is functioning properly and how to correct some
common problems. The document also provides examples of common Archivalist configuration changes and
guidelines for data archive maintenance. Note that Archivalist is not a backup utility and it is up to the SeaSonde user
to periodically copy your important data and configuration files to a more permanent storage.

About Archivalist

Archivalist is a utility application for maintaining output folders that build up with
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lots of data files. Archivalist will create archived copies of the files while maintaining a limited number of source and
archived folders/files (limiting means it will delete older data as configured.) The SeaSonde Radials Site produces
many different types of output files time stamped at various intervals. Archivalist organizes copies of the data files
into /Codar/Archives/ and keeps the data folders from filling up with too many files in order to prevent the hard disk
from filling up. The default limits for a Radial Site are meant for typical hard disks with room left over for future data
like bistatic and other add-ons. If your hard disk, is less than 80GB you will want to reduce these limits. If you hard
disk is much larger, you might want to increase these limits to hold more data on site.

Archivalist can also copy data to an external drive which can be used to transport data offsite; see Copy an archive to
an external disk below.

Check Archivalist function and configuration

e Look at the Archivalist icon in the Dock. Confirm that there is an application-open indicator below the icon.

Archivalist

e Click the Archivalist icon in the Dock to open Archivalist or make it active.

Check settings

e Choose Control > Change Archives.... The Archive Control dialog appears.
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e Review the checkboxes in the Archives pane and confirm that the expected archives are selected.
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e Click each archive name in the Archives pane and review its settings in the other panes. Confirm that the
settings are correct.

e After the settings are confirmed observe the Sources and Archives data amounts and confirm that data is
being stored.

Check archives

In the Finder, confirm that files are correctly archived. Archives are normally in /Codar/SeaSonde/Archives.

e  Confirm that archives are located in the folders specified by the Archivalist settings.
e  Confirm recent archiving by checking file-created dates for recent dates and times.

Confirm the archive sizes for each archive folder:

Select an archive folder.

Choose File > Get Info. An Info window appears.

In the Info window’s General pane, confirm that the number of archived files or archive sizes are
the same as the settings.

The Archive Control settings may be empty. If the settings are empty, see Restore Archive Settings.

Check status and disk usage

In Archivalist, choose Window > Show Status Window. The Status window appears.

Review the Status window entries for any red-colored error messages. If there are any errors, correct them.
Click the CodarData disk on the desktop.

Choose File > Get Info in the Finder. The CodarData Info window appears.

In the Info window’s General pane, confirm that the available disk space is at least 5 Gigabytes (GB) or 10%
of the disk’s capacity, whichever is less.

If the available disk space is less than 5 GB or 10% of the disk’s capacity,

e change the Archivalist settings to reduce the archive size (see Archive Configuration Examples)

or

e delete the oldest archive files (after backing them up, if desired).

If an extra copy is made to a separate disk,

e check the disk’s available space.

If the disk is nearing its capacity,

e delete the oldest files on the disk

or
e exchange the disk for a disk with more available space.

e If you encounter problems that you can not solve, open
/Codar/SeaSonde/Apps/Scripts/SeaSondeReportsHigh. A report file
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/Codar/SeaSonde/Logs/RPT_XXXX_YYYYMMDD_HHMMSS_hi.zip is created. Email the report to
support@codar.com with an explanation of the problem and your attempts to solve it.

Restore empty archive settings

Use the following procedure if you discover that the Archive Control settings are empty. That is, all the checkboxes in
Archive Control dialog’s Archives pane are deselected and all the archive names are blank.

Quit Archivalist

In Codar > SeaSonde > Configs > RadialConfigs delete the file Archivalist.plist

On the Dock click the Archivalist Icon to restart Archivalist. The program will automatically generate a new
default property list with standard archive settings.

In Archivalist go to Control > Edit Archives

Confirm the settings are correct.

Archive Configuration Examples

The following examples demonstrate how to make some common configuration changes. Refer to the SeaSonde
Radial Suite Application Guide for Archivalist for complete details on archive configuration.

Reduce archive limits to increase available disk space

You may discover that your archive configuration does not leave enough available disk space. In this example, you
decide to reduce the number of ideal-pattern radials data files that are archived.

e Some of the archives will be deleted when the limits are reduced. If you want to back up the current
archives, do it before reducing the limits.
Choose Control > Edit Archives.... The Archive Control dialog appears.
Click Radials LLUV Ideal in the Archives pane.
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Note that 168 files are duplicated in the source folder. These are seven days of data. (168 files / 1 file per hour / 24
hours per day = 7 days) You decide to reduce the duplicated files in the source folder to three days of data. 3 days * 1
file per hour * 24 hours per day = 72 files.

e Enter 72 in the “duplicated file(s) in source folder” field of the Source pane.

Note that 104 weekly archives are duplicated to the destination folder. (“Limit 104 weekly folder(s) in destination” in
the Destination pane.) These are two years of data. (104 folders / 1 folder per week / 52 weeks per year = 2 years)
You decide to reduce the duplicated files in the destination folder to 1 year of data. 1 year * 1 folder per week * 52
weeks per year = 52 folders.

Enter 52 in the “Limit ... weekly folder(s) in destination” field of the Destination pane.
Click the Save button. The changed configuration is saved.
Click the Run Now button. If the previous archive sizes exceed the new settings, the archive sizes are
reduced to the sizes of the new settings.
e Archivalist automatically organizes archived folders by using a token replacement system as shown below.

Destination

Archive {Codar/Seasonde/Archives [Spectra/
() Duplicate Move source file to archive. Fip each archive file.
o ey P L N A -
PosOCES_ ] Prefix Weekly folders with |FCOL €50 2012 Woe_Feb]
[14 Limit | & | weekly folden(s) in destination.

Note how the XXXX’ token is replaced by the site four letter code.

Copy an archive to an external disk

In order to archive to an external drive proceed with the following.

e  Connect the external FireWire disk drive to the SeaSonde computer.
e In the Finder, rename the external disk “CodarArchives”.

The normal settings backup all selected archives to the CodarArchives disk. To review the settings or change which
files are backed up. A second drive can be simultaneously be connected to the computer under the name
“CodarArchives2”.

In Archivalist, choose Control > Edit Archives.... The Archive Control dialog appears.

Click an archive button in the Archives pane.

Deselect the “Also, backup the archives to” checkbox and/or the “if above fails, then try” checkbox for any
archive items that are not to be save to the connected external drives. Archivalist is by default set to archive
all active archive items to the “CodarArvchives” and “CodarArchives2” drives if they exist.

Click the Save button if you change a setting.

Repeat for each data archive.
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CODAR Support Services

SeaSonde Training and Self-Help Resources

Training Courses

CODAR offers 3-day basic training courses at its Mountain View, CA Headquarters twice per year. One free basic
course tuition is included with each SeaSonde purchased. Contact support@codar.com for course information and
reservations. Course dates and descriptions are posted on our website hitp://www.codar.com. Onsite training can
also be purchased.

CODAR highly recommends that operators of SeaSondes HF radar systems attend a basic training session prior to
equipment installation.

SeaSonde Support Website

CODAR Technical Support hosts a support website at support.seasonde.com. The login and password for the
T.I.P.S. page (Technicians Information Pages for SeaSondes ) is provided to all new SeaSonde owners at the time of
purchase. The TIPS pages are updated with the latest software bug fixes, answers to commonly asked questions
and tutorial video screencasts for explaining how to perform the most common tasks.

HF Radar Library

A comprehensive “pdf library” of peer-reviewed publications pertaining to oceanographic applications for HF Radar
can be found at http://www.codar.com/bib.htm. Most of the articles are full-text documents and can be downloaded as
pdfs.

How to Get Technical Support

If you require technical assistance and have a support service contract on file with us, please feel free to email
support@codar.com or call +1 408 773 8240 and ask the operator to speak with a member of our Technical Support
staff. There is no charge for short answers (~ 5 minutes or less) but at a minimum, we do require that a CSERV-A
support services contract be setup in advance.

The Principal Investigator/Owner of the SeaSonde(s) and his/her authorized technicians are identified in the contract
forms along with correspondence and billing addresses.

Setting up a Support Services Account

To set up a Pay-As-You-Go (CSERV-A) service contract or to purchase pre-paid Time-Bundle (CSERV-B), please
complete the appropriate form and email it to support@codar.com or fax it to the attention of Technical Support
Services at +1 408 773 0514. Forms are also available on the support.seasonde.com website and in the Appendices
at the end of this document.

CODAR also offers more comprehensive service plans that include pro-active service checks and maintenance by
our staff. Annual site visits can also be provided if required. Please contact support@codar.com for custom pricing
for our CSERV-C and CSERV-D plans.
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No-Charge Services

CODAR will not charge for time spent diagnosing software bugs or for doing the requisite diagnostic checks provided
that an RMA is issued and the equipment is returned to CODAR for repair.

If the software or hardware problem/complaint turns out to be a user configuration error or is a result of improper
operation, then we will invoice the user for the Technical Support consultation on an hourly scale.

If an RMA is issued as a result of a remote diagnosis made by a CODAR technical support staff member and the
hardware is not returned for repair within 30 days, we will also invoice for time spent diagnosing the problem.

Reporting Problems to CODAR

Identifying a problem

Prior to contacting CODAR’s Technical Support Services department please prepare a detailed description of the
problem and collect and email the latest SeaSondeReports log (if applicable). We will also need the serial numbers of
the equipment and the remote contact information for the sites (IP addresses and any custom passwords).

If your SeaSondes are running CODAR SeaSonde Release6 or later software with RadialWebServer, please provide
the URL and password for RadialWWebServer access.

One-click Diagnostics Using SeaSondeReports

The best way to report information about your remote unit’s status to CODAR Support is to run one of the
SeaSondeReports scripts available on SeaSonde sites with Release 5 or higher installed. When run, the scripts
create a zipped file containing a bundle of system logs, SeaSonde data and diagnostics files.

via the RadialWebServer Display
Go to the Logs section of the RWS page and click the Generate button

SeaSonde Radial Site SONG

Status Sae Log Entry
Diatals Erior new sitn evert:

Winves

Spectral™ Deagnostic Rspart

Logs

Saltings . £ Seranal SONG 20t MM 0y
! Seennel SONG 201 38000

St SOHO 2012041 Serandd SONG 20138300

Sl SO0 30 ; Secinal SOHD_201 30T o5
Saniival_SOHD_I0EN0T 14, At SOMG_2DEIE1 1 log

via the Desktop

The SeaSondeReports scripts are found in the /Codar/SeaSonde/Apps/Scripts/ folder. There are two scripts:
SeaSondeReportsHigh and SeaSondeReportsMedium. The primary difference between them is the amount of data
bundled. To keep the zipped bundle under most email file size restrictions, run SeaSondeReportsMedium. On
computers set up by CODAR, it can also be run from the Dock by clicking the following icon:
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SeaSondeReports Icon

When run, SeaSondeReportsMedium will create a zipped file of bundled system logs, SeaSonde data and
diagnostics on the Desktop approximately 10 MB in size with the following name format:

RPT_XXXX_YYYYMMDD_hhmmss_md.zip

This file should be emailed to support@codar.com and please include any additional description of the circumstances
surrounding the issue and/or recent site configuration changes that might help us in our analysis. If immediate
assistance or a prompt response is required, our standard support policy and rates apply, but submission of the
zipped report files is always free and all submissions will be reviewed.

Returning Equipment to CODAR

Procedure

CODAR personnel must authorize any return of materials or hardware for repair, upgrade or exchange. Complete
the following steps to avoid delays and additional charges:

Confirm with a CODAR support engineer that your equipment needs to be returned
Provide the following information to request RMA number.
Serial number(s) of the equipment/modules/parts.
Describe the problem/type of failure.
If any troubleshooting steps were already carried out and results of the tests.
Return shipping address for the equipment.
Billing address for the RMA fee.
Any corresponding diagnostic files or SeaSonde Report file that may help the CODAR support and testing
teams to troubleshoot your problem.
e Send above information to CODAR by one of the following methods:
e email: support@codar.com (preferred method)
e fax: 408-773-0514. Attention to Technical Support department
e voice: 408-773-8240; a Technical Support Representative will assist you.
e mail: 1914 Plymouth St., Mountain View, CA 94043
A CODAR Support Engineer will issue an RMA number for the authorized return.
Pack the equipment/materials and clearly label the package with the RMA number.
Ship the materials to CODAR in a sturdy packing to avoid damage in transit.

CODAR will notify the customer’s contact personnel that materials were received.
CODAR will notify the contact person about analyses performed, recommended repairs, price estimates, etc.

Notes:

1. Materials out of warranty will be assessed an analysis and repair fee.
2. Dirty or corroded materials may be assessed a cleaning fee.
3. Direct the inquiries about the status of any RMA to rma@codar.com.
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Hardware Troubleshooting Procedures

Troubleshooting Flow Charts

SeaSonde Receiver Tests

SeaSonde Receiver Bench Tests

If you see Red light in the front panel of the RX, then first test if the Receiver 5V supply
is working properly.

Test 1:

e Using Multi-meter, measure voltage between pins 1(red and white cable bundle)
and pins 2(black wire:ground) on the small power supply, located on the left
panel of the RX chassis as shown in Figure.

e The multi-meter will read around +5V as shown in Figure, if the 5V power supply
is working properly.

e Ifitis off by around + 0.3V, then there may be a problem with this power supply
and you need to return the equipment to Codar.

+5V supply in the receiver chassis.

133



SeaSonde SSRS-100 Operator’s Manual

If +5V power supply is working fine, check to see if the front panel board is receiving this
+5V supply. Follow test 2 to measure +5V on the front panel board.

Test 2:

e Remove the screws from the front panel board and place it so that it is
convenient to measure voltages using multi-meter as shown in Figure.

e Place the positive(red) probe on pin 1 of the big capacitor C21 in front of the
serial connector as in Figure. Pin 1 is marked by a thin strip as shown by arrow in
Figure.

e Place the negative(black) probe on the ground of the Front panel board as shown
by arrow in Figure. You can use any one of the holes on the Front Panel Board,
as in Figure as ground or the aluminum chassis as the ground.

Measuring 5V on C21 on Front Panel Board

e The multi-meter should read around 5V as shown in Figure.
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Front Panel Board 5 V measurement

e If +5V on Front Panel Board is not working correctly, and if the +5V supply as
measured in Test 1 is working correctly, then either the ribbon cable is bad or
there is a problem in the front panel board.

e In most of the cases, it is the front panel board problem and ribbon cable problem
is extremely rare. So if you have a spare front panel board, then swap it and see
if it works. Then you can determine, if it is the front panel board problem or any
other problem.

e If Front panel 5V is working correctly, then follow Test 3.

Next step is to measure 3.3V supply on the Front Panel Board.
Test 3

e First, locate capacitor C2 near serial connector J2 as shown in Figure 9 by red
circle.

e Place positive(red) probe on pin 2 of C2 as shown in Figure 9 and place the
negative(black) probe on one of the ground holes of the front panel board or the
chassis as described in step 2.

The voltmeter should read around 3.3V. If its not close to 3.3V then it means that the
power regulator is not working and you need to return the front panel board for
repairing.
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Measure 3.3V on Capacitor C2 on Front Panel Board

If, both 5V and 3.3V are working correctly on the front panel board, then most probably,
it may be the problem with some other module.

Basic AWG module Test
To verify if AWG module is running properly follow the following steps.

The most basic measurement on AWG module that SeaSonde users can make, is to
measure +5V supply on the AWG module.

e Before that, you can first check the +5V reading using software.

e In the SeaSonde Crontroller “Advanced” controller window, type the command
“prpt” in the “Send” window.

e The status window will show the reading of +5V as shown in Figure below.
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2546 RC1l:Write prpti\r
2547 RC1l:Read prpt
2548 RC1l:Read RFPV: F9

2549 RC1l:Read FPAD: 00 00 C8 CA AC 00 00 FO
2550 RC1l:Read SPO0O5: +5. 18v @¢§f——--—
2551 RC1l:Read SNO5: =-5. 13v

2552 RC1l:Read SP1l2: +12.31lw

2553 RC1l:Read SP24: +0. 00w

2554 RC1l:Read FPHT: +27.C +80.F

2555 RC1l:Read XRPT: 81 Unable to Get Transmitter Chassis 00
2556 RC1l:Read OK.

2557 RC1l:Read >

SeaSonde Controller Status Window

If the above reading is not close to +5V +/- 0.5V, then you can confirm the reading by
manual measurement using multi-meter.

First open the lid of the AWG module.

Locate capacitor C104 as shown in Figure 11.

Switch on the Receiver before making any measurements.

Place the positive (red) probe of the multi-meter on pin 1 of Capacitor C104 as
shown in Figure 11. Pin 1 is the pin with a marked thin stripe as shown.

You can also probe on Pin 14 of the big serial connector J2 as shown in Figure 7.
The reading should be close to +5V. If it is off by + 0.5 V or more, then there may
be some problem with the 5V power supply or any of the other modules.
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AWG +5V measurement

* In case of wrong reading on AWG module, measure +5V on the front panel board as
explained above and the +5V on the main power supply as explained above.

* If both these supplies measure 5V correctly, then it may be a problem with one of the
other modules or some cable problem inside the receiver chassis.

SeaSonde Transmitter Tests

Transmitter Bench Tests

There are three components in the transmitter that can affect the power output to the
antenna. If any one of them has failed or is compromised you will likely have no forward
power (signal) being transmitted. The primary components are the 28V DC Vicor power
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supply,(or 24V DC power supply for systems shipped after Sep’08), the blanking board
and the Kalmus amplifier. All the cases below are for 28V DC power supply.

Tools you will need:

For these tests you will need a receiver chassis, a transmitter chassis, a multi-meter, a
dummy load (also referred to as a dry load) and screwdrivers (flat bit and Phillips).

A NOTE OF CAUTION:

Some of these bench tests will require disconnecting wires or probing components with
a multi-meter while the hardware is plugged in. For safety, turn off the transmitter

while preparing for each test and turn it on only when you are ready to take a reading.
Always be aware of the power's on/off status.

 Before beginning any tests on a transmitter that has an input signal from a SeaSonde
receiver, please be sure to connect a dummy load(or the Transmit Antenna RG-8 cable)
to the transmitter's "N" type antenna connector (see Figure). Failure to do this can result
in significant and expensive damage which may require replacement of the transmitter's
amplifier. The first step (with the power off) is to remove the top covers from the receiver
and transmitter chassis.

Dry load connected to Transmit chassis
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Test 1:

e With the transmitter turned on, probe the two screws of the big blue capacitor
(one probe on each screw) next to the Vicor power supply as in Figure.

e You should get a reading of approximately 28 V DC. If the voltage is off by more
than a volt or two and the voltage has been consistently low (or high) in your
diagnostic STAT files, then assume that there may be a power supply problem
and continue to the next test.

28V DC power supply measurement.

e |[f the voltage is significantly low (less than 18 VDC for example), this may be an
indication that the Kalmus amplifier has failed and is "pulling down" the voltage
output from the Vicor. We will check this in the next step.

CAUTION: Be sure to turn off the transmitter before disconnecting any wires, then
turn it back on again.

Test 2:

* To test if the amplifier is receiving power at all or if it is "pulling down" the voltage
coming from the Vicor supply, disconnect the yellow wire bundle from the blue capacitor
as shown in Figure. Disconnect the yellow wire bundle, which has one thin yellow wire
as shown in Figure.
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Disconnect Yellow wire Bundle

Set the receiver to "pulse" mode using your normal operational settings so that a
transmit signal is being sent from the receiver to the transmitter. The transmit
drive cable and the serial control cable must be connected and a dummy load
attached.

Turn on the transmitter and probe between the yellow wire bundle that you
disconnected from the capacitor and the negative terminal of the capacitor as
shown in Figure.

The reading on the multi-meter should be around 28 Volts DC. If the reading is
lower than 28 volts by more than one volt then there may be a problem with the
Vicor power supply.

If the reading was previously ~ 18 VDC or less and is now reading 28 VDC with
the wire bundle removed, then most probably, your Kalmus amplifier has failed.
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28V measurement across the cable bundle.

If your power supply voltages are good and if still, there is no transmit power, the
problem may be your blanking board.

First, make sure that the serial cable and transmit drive cable are in good
condition and attached, then proceed with the test below.

Test 3:

To determine if the input signal is reaching the blanking board, place the
positive(red) probe on the first wire terminal lug (a.k.a. pin "10") of the blanking
board and the black probe on chassis ground as shown by arrows in Figure 5.
The reading should be approximately 1.4-1.5 volts DC. If it is not and you're sure
that the transmit drive cable and transmit serial control cables are in good shape,
then you can assume the blanking board has failed.

Blanking boards are user replaceable (for experienced users).

Remove the two chassis mounting screws and pull the board out from its socket.
Replace with a new board and re-assemble.

If this solves the problem then you won't have to return your SeaSonde
transmitter to COS.
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Measuring Blanking Board voltage

Antenna Cable Tests

Antenna Tests

Test 1: Resistances of the Antenna Connectors at the Receive Antenna
Box

e Turn off the transmitter chassis.
e Turn off the receive chassis.
e Take down the receive antenna.
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Unplug the antenna cables at the end of the receive antenna

Set the multi-meter to measure resistance in the kilo-Ohm range.

Measure the resistance across each connector from the bottom of the receive
antenna box in the following manner:

Place the black probe on the outside shield of the connector.

Place the red probe on the center pin.

Resistance of Loop 1 and 2 connectors should be each close to 1500 ohms.
If they are not close to 1500 ohms, there may be a problem in the Receive
Antenna loop-stick box.

Resistance of Monopole connector should read an open connection or some very
high resistance in Mega Ohms range.
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Repair and Maintenance

Rack Mountable Electronic Chassis

Repair

For electronic chassis (RX and TX), there is no user serviceable parts. The repairs should be
done by the manufacturer or it's authorized service representatives. See section “Returning
Equipment to Codar” for instructions on procedures.

Maintenance

In general, if the equipment is housed in a sealed and environmental controlled room or cabinet
as recommended, the equipment requires no regular maintenance.

Power Cords

If power cords were to be replaced and sourced locally, the power cord of the same design
should be used with the current rating no lower than 10 A.

Fuses

Fuse housing is integrated into the power switch module. On each fuse holder there is also a
spare fuse attached. To source the fuse locally, use a slo-blo fuse. The current rating should be
5Afor 110 V systems and 2.5 A for 220 V systems.

Cleaning

For cleaning, use a dry soft cloth to wipe the exterior only. No fluid should be used for cleaning.
Cleaning of the interior of the instrument should be performed by the manufacturer and its
certified representatives only.
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Appendix A Specifications

Radiated Signal Specifications

Operators must adhere to local radiated signal regulations and receive proper authorization
prior to operation. Licenses should be obtained by the system operator/owner prior to
transmission. During manufacture, the system can be tuned for operation at a user-specified
frequency, typically one of the authorized oceanographic radar bands as defined by ITU, or any
other band authorized by presiding local authority. Transmitted signals are within the latest ITU
guidelines for oceanographic HF radar.

Output Radiated Power: 80 W peak, 40 W average
Operating Frequency Range:
Electronics: 4.4 - 50 MHz (selected specific frequency for filter tuning_
Antennas: Select a frequency between 4.4 - 50 MHz
Modulation Format: Pulsed Swept Frequency CW (FMiCW)
Sweep Width: 12 - 300 kHz (typical)
Pulse Repetition Frequency: 1 -4 Hz
Total Radiated Signal Bandwidth: (at -20 dB level) 65 - 200 kHz)
Polarization: Vertical
System Power Requirement (transmitter, receiver & computer):
350 W (24V DC version)
500 W (120 - 220 VAC version)

Transmitter Specifications

Transmitter Chassis model prefix: SSTX
Input RF Drive Level: 0 dBm
Output RF Power Level: 100 W peak, 50 W average
Power Requirements:
110 W (24 VDC version)
200 W Nominal, 300 W Maximum (120 - 220 VAC version)
24 VDC or 120 - 220 VAC, 50 - 60 Hz, single phase
Overvoltage Category: Category Il
Power Amplifier Design: (gated FET) modular; solid state
Power Amplifier Operation: Class AB
Dimensions: (single chassis) 19” rack mountable, 3U tall; 13H x 49W x 53D (cm)
Weight: 15 kg
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Environmental Condition Ratings:
Temperature Range (ambient): 0°F (-18°C) to 90°F (32°C)
Maximum Humidity: 80% non-condensing
Maximum Altitude: 2000 m
Pollution Degree: 2

Receiver Specifications

Receiver Chassis Model Prefix: SSRX
Maximum In-band Input Level: 0 dBm
Receiver Channel Impedance: 50 ohm
Sensitivity (noise level): -166 dBm in 1 Hz BW
Power Requirements:
200 W Nominal, 300 W Maximum
24 VDC, or 120 VAC, 50 - 60 Hz, single phase or 220 VAC, 50 - 60 Hz, single phase
Overvoltage Category: Category Il
Design: Modular, solid state, three channel
Operation: 1/Q homodyne
Output: USB digital output; digital data at 4096 16-bit/second per channel
Dimensions: (single chassis) 19” rack mountable, 3U tall; 13H x 49W x 53D (cm)
Weight: 14 kg
“SHARE” GPB-enabled modulation multiplexing Synchronization Feature:
GPS-assisted stability: 10 ns
PPS resolution: 0.1 ns
Environmental Condition Ratings:
Temperature Range (ambient): 0°F (-18°C) to 90°F (32°C)
Maximum Humidity: 80% non-condensing
Maximum Altitude: 2000 m
Pollution Degree: 2

Computer Specifications

Computer Model Number: SSDA 101
For mini-style computer
Power Requirements:
150 W
100 - 240 VAC, 50 - 60 Hz, single phase
Operating Temperature: 50°F (10°C) to 95°F (35°C) for mini-style computer
Storage Temperature: -40°F (-40°C) to 116°F (47°C)
Relative Humidity: 5% to 90% non-condensing
Compatible Communications: 10/100/1000 Base-T Ethernet (RJ-45 connector) & Others
(such as dial-up modem)
Interface to SSRX: USB A
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SeaSonde Enclosure Specifications

Model Prefix: ENC36-B
Enclosure construction
NEMA 4X indoor/outdoor use
Welded Type 304 Stainless steel construction
3/4” thick foam core insulation
laminated poly/aluminum facers
Dimensions: 36"h x 24"w x 32°d
Weight: approx. 200 Ibs.
Access Doors
Two doors (front and rear),
each fully gasketed, hinged left, latched right
Door Latches
Standard 1/4 turn latches, top right latch per door,
“barrel style” and padlockable (padlock not included)
Grounding Studs
Grounding studs (4) on doors and inside enclosure
Rack Rails
Side flange style with punched (not tapped) holes, for use with “clip-nuts” (included).
Approx. 32” high and horizontally-adjustable (front-to-rear) on uni-strut
Cable Exit Plate
Type 304 stainless steel
Dimensions:5.5"h x 13.5"w
Gasket covering 2°h x 12"w cable exit cut-out, plate
Mounting Tabs
4 built into enclosure (two on right, two on left)
Air Conditioners- 2 included
Thermoelectric solid state
Built-in adjustable thermostat
Stainless steel covers
Stainless steel mounting flange (20-1/4"h x 13"w)
Neoprene mounting gaskets
Stainless steel mounting fasteners
Certification to UL/CSA standards
Condensation Treatment
One condensate drip pan per cooler
Drip pan fittings and length of flexible PVC drain tubing plumbed with enclosure
Small drain holes on right and left sides of enclosure (towards bottom)
Air conditioner Requirement:
1500 BTU/HR rating (each). Optional upgrade to 2500 BTU available for purchase.
NEMA 4X configuration
220 VAC (4.6 amps) (or, specify 110V instead of 220V at time of ordering)
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Air conditioner dimensions
Through-mount design, will protrude 3-5/8” into enclosure

TExposure to direct sunlight can act as another heat input to enclosure and therefore should be avoided, especially in warm climates.

TtSpecifications and appearance are given as guidelines and may change without notice.

Transmitter & Receiver Chassis Symbol Explanations

Caution, risk of electric shock
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Appendix B Dome Combine Antenna Mounting
Template
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Appendix C Box Style Receive & Combined T/R
Antenna

Note: the SeaSonde receive antennas and combined transmit/receive antennas are mechanically similar and
identically assembled. These instructions are applicable to either type of antenna.

Box Style Receive Antenna

When assembled and raised, the antenna is
approximately 7 meters tall. The antenna consists of
five antenna elements, made of fiberglass whips, a
base that contains electronics, a two-piece mast and
cables. The cables are routed through the hollow
aluminum tubing of the mast. The two mast pieces are
mated with a plastic coupler. The cables are connected
to the base. The base is connected to the mast. The
antenna elements are attached to the base.

Receive
Antenna
Base

Element ]

Element
Parts List
Qty Description
1 cable set, 100 meters
1 mast, lower section
1 mast, upper section
1 mast coupler
2 screw, hexagonal head (cap bolt), 4-20 x 3/8 inch
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1 antenna box

2 screw, hexagonal head (cap bolt), 4-20 x 3/8 inch

1 fiberglass whip, vertical element (see table below for lengths)

4 fiberglass whip, horizontal element (see table below for lengths)

Fiberglass Whip Lengths

SeaSonde Frequency | Vertical Fiberglass Whip Horizontal Fiberglass
Length Whip Length
4.3-54MHz 8 ft 8 ft
11.5 - 14.0 MHz 8 ft 8 ft
24.0-27.0 MHz 8 ft 4 ft
40.0 - 44.0 MHz 64 in 30in

Tools List

e wrench, 7/16 inch (socket with short extender recommended)

Procedure

e One at a time, insert the end of each cable in the large hole at the upper end of the lower mast section. Be
sure to start with the largest connector first.

e With all connectors inserted, gently push the cables until they appear at the upper end of the mast section.
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e One at a time, insert the end of each cable in one end of the mast coupler and push it through the coupler

until it appears at the other end. Be sure to start with the largest connector first.

e With all cables threaded through the coupler, insert the coupler in the upper end of the lower mast section.

Align the threaded hole in the coupler with the hole in the mast. Insert a 1/4-20 x 3/8 hexagonal-head screw
(cap bolt) through the hole in the mast and screw it into the coupler. Gently tighten the screw with a wrench.
Do not over tighten. The threads in the coupler are easily stripped.
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Insert the cable ends and coupler in the lower end of the upper mast section.

Align the threaded hole in the coupler with the hole in the upper mast section. Insert a 1/4-20 x 3/8
hexagonal-head screw (cap bolt) through the hole in the mast and screw it into the coupler. Gently tighten
the screw with a wrench. Do not over tighten. The threads in the coupler are easily stripped.

e Gently push the cables toward the top of the mast until they appear at the top.
e Remove the four bolts that fasten the black mounting sleeve to the antenna box.
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e Thread the cables through the mounting sleeve and connect the cables to the antenna box. Refer to the
diagram on the antenna box and match the cable labels with the corresponding base connectors. Finger
tighten the connectors. Do not use a wrench or pliers.

SeaSonde

e Reattach the black mounting sleeve with its four bolts. Tighten securely with a wrench.
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Mount the antenna box to the mast. Make sure the mast is fully seated in the mounting sleeve.
There are two bolts that secure the antenna box to the mast through threaded holes in the black mounting
sleeve. Tighten the two bolts securely with a wrench.

e The antenna has five fiberglass-whip elements. The elements are screwed into threaded holes in the
antenna box. One element is oriented vertically, screwed into the top of the base. The remaining four are
horizontal, screwed into holes at each corner of the base. The lengths of the elements vary, depending on

the SeaSonde frequency.

Some older SeaSonde models have two-piece antenna elements. The two-piece elements are used with 4.3 - 5.4
MHz (Long Range) and 11.5 - 14.0 MHz (Standard Range) SeaSondes.

Coat the metal couplers with a moisture-proof lubricant. Dow Corning 4 Electrical Insulating Compound is
recommended. Push the two pieces together, ensuring they are firmly and completely mated. Wipe off any excess
lubricant. Wrap the exposed metal coupler where the two pieces mate in electrical tape.

e Find the vertical element and coat its metal male threads with a moisture-proof insulating lubricant. Dow
Corning 4 Electrical Insulating Compound is recommended.
e Insert the vertical antenna element in the threaded hole on the top of the base and screw it in. Tighten

securely using a wrench.
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e Coat the metal male threads of a horizontal antenna element with a moisture-proof insulating lubricant.
Insert the antenna element in a threaded hole on side of the base and screw it in.

Note: The fine threads are easily cross threaded and can damage the Helicoil insert. Thread the whips by hand first,
then tighten with a wrench.

e Tighten securely using a wrench. Repeat for the remaining three elements, installing at each corner of the
base.
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The SeaSonde receive or combined transmit/receive antenna is assembled.

Transmit Antenna Assembly

12 MHz and Above

The transmit antenna consists of a two-piece mast, a feed, fiberglass whips and a cable. The cable is routed through
the hollow aluminum tubing of the mast. The two mast pieces are mated with a plastic coupler. The cable is
connected to the antenna feed. The feed is connected to the mast and vertical and horizontal fiberglass whip
elements are attached. When assembled and raised, the antenna is approximately 7 meters (24-27 MHz SeaSondes)
or 9 meters tall (11.5-14 MHz SeaSondes).
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fiberglass
whips -

Parts List
Qty Description
1 cable, RG-8, 75 meters
1 mast, lower section
1 mast, upper section
1 mast coupler
2 screw, hexagonal head (cap bolt), 4-20 x 3/8 inch
1 antenna feed
2 screw, hexagonal head (cap bolt), 4-20 x 3/8 inch
1 fiberglass whip assembly, vertical element, four mating sections for
11.5-14.0 MHz SeaSondes or two sections for 24-27 MHz
2 fiberglass whip, horizontal element, 8 feet long
Tools List
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e wrench, 7/16 inch
e moisture-proof insulating lubricant. Dow Corning 4 Electrical Insulating Compound is recommended.

Procedure

e Insert the end of the transmit cable into the large hole at the upper end of the lower mast section.

e  Gently push the cable until it appears at the upper end of the mast section.

e Insert the cable into one end of the mast coupler.
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Gently push the cable through the coupler until it appears at the other end.

Coat the lower end of the coupler with moisture-proof insulating lubricant.

With the cable threaded through the coupler, insert the coupler into the upper end of the lower mast section.
Align the threaded hole in the coupler with the hole in the mast. Insert a 1/4-20 x 3/8 hexagonal-head screw
(cap bolt) through the hole in the mast and screw it into the coupler.

Gently tighten the screw with a wrench. Do not over tighten. Over tightening can strip the coupler threads or crack the
coupler.

e Insert the cable end and coupler into the lower end of the upper mast section.

161



SeaSonde SSRS-100 Operator’s Manual

e Coat the upper end of the coupler with moisture-proof insulating lubricant.
e Align the threaded hole in the coupler with the hole in the upper mast section. Insert a 1/4-20 x 3/8
hexagonal-head screw (cap bolt) through the hole in the mast and screw it into the coupler.

Note: Gently tighten the screw with a wrench. Do not over tighten. Over tightening can strip the coupler threads or
crack the coupler.

Gently push the cable toward the top of the mast until it appears at the top.

e Coat the cable connector threads and the antenna feed connector threads with moisture-proof insulating
lubricant.

e  Connect the cable connector to the antenna feed connector. Finger tighten the connectors. Do not use a
wrench or pliers.
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e Apply moisture-proof insulating lubricant to the lower metal section of the antenna feed. Coat the areas that
will touch the mast when the antenna feed is inserted.
e Insert the antenna feed into the upper end of the mast.

The horizontal antenna elements are white fiberglass whips.

Note: Some older SeaSonde models have two-piece antenna elements. Coat the exposed metal ferrule with
moisture-proof insulating lubricant. Push the two pieces together, ensuring they are firmly and completely mated.
Wrap the exposed metal coupler where the two pieces mate in electrical tape.

e  Align the threaded holes in the feed with the holes in the mast.
Coat the metal threads of a white fiberglass horizontal antenna whip with non-conducting silicone grease
(Dow Corning DC-4 recommended).

e Insert the antenna element through the mast hole and screw it into the feed. Tighten securely using a
wrench.
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e Coat the threads of the second antenna whip with non-conducting silicone grease (Dow Corning DC-4
recommended).

e Insert the antenna whip through the mast hole opposite (180 degrees away from) the whip previously
installed. Screw the whip into the feed by hand to ensure proper thread contact. Tighten securely using a
wrench.

The vertical antenna element is a green fiberglass whip. The whip is made of four sections for 11.5-14 MHz
transmitters or two sections for 24-27 MHz transmitters. From bottom to top, each section is progressively thinner.

e Insert each vertical antenna section’s metal coupler into the the next section’s socket. Coat the antenna
connection with DC-4 silicone grease and push the sections firmly together and hand-tighten it

e Insert the antenna feed into the vertical antenna element. Twist the pieces firmly and completely together by
hand. Do not use a wrench or tool.
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Assembly of the SeaSonde transmit antenna is now complete.
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Appendix D SeaSondeRadialSetup Default Settings

The following screen shots show the default settings for Standard Radial Site operations and data averaging times.
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Appendix E Optional Configuration Tasks

Find frequency with least interference

e  With transmitter off, collect at least one full CSQ file for each of your assigned operating frequencies.
e Open a CSAQ file collected at each frequency using the application SpectraPlotterMap.
e Examine range cell #5 comparing noise floor values on each antenna.
e Inspect each range cell for interference striping (horizontal or vertical stripes).
e Choose the frequency with the lowest noise and no interference for your primary operating
frequency.

Create a site map for viewing surface currents

e Launch SeaDisplaySetup (/Codar/SeaSonde/Apps/Tools/SeaDisplaySetup)
e Pull down File->New to create a new map

e Zoom the map in until it covers the area of interest:

» Option + Up arrow/Down arrow keys zooms in and out
« Shift + Left/Right/Up/Down arrows adjust the Left/Right/Up and Down frame boundary

e Left/Right/Up/Down arrows adjusts Left/Right/Up and Down position within the frame
e Choose the View > Map Navigation or View > Speed Hints to see details on navigating the map
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Pull down Map->Sites menu
Click “OK” to dismiss “Sites dialog usage...” help box

= m  Slhes dialog usage...
. First use the <Add > button to make space for sach site. Then
'I edit the "default’ semtings o suit your purpose. Click once on

the map to activate its window, Then double click on the map
for automatic sive becation.

Click “Add” button in “Site Definition”

. Name |S000

== Show (@) Lon, Lat () Bearings
L] Longitude |122° 2' 6.01°W

=n Latitude | 36° 56 47.00°N

*‘:M Settings | More.. |

 Warn Optional | Grid... |

| Reset | | Add | | Dalete | | Draw || Ok |

e Replace “Name” box entry “SCrz” with your four-character site name.
e  Enter latitude and longitude as D.DDDD, DDD MM.MMMM or DDD MMM S.SS.
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Note: Disregard degree-minute-second symbols, make sure to include N,S,E,W as appropriate.

e  Click “More ...” button
e Check mark “name” in Labeling options Release7-SeaDisplaySetup-SiteDialog

- Sili SEUtngs

Coverage display —
k(1505
Max argles Dyaree bearing limits

Apply Max km to all sies (Mo unde)

Ramge rimgs {using Grid... infol
Diraw mvery 0 th ramgs rirg

Symbal ppthons

Approx size | 109 %

Calar | B

Outline | [

Owtlne only

Labeling cptions

Content ¥ number name

Flaceman Right, upper

Appearance Tian prap.,

Cancel Defaults L Ok

e Enter expected range in “Coverage display: Max Km”

(Defaults: 15km for 42MHz, 45km for 256MHz, 75km for 12MHz, 185km for 5MHz)

Click “OK” to dismiss “More...” dialog

Click “OK” to dismiss “Site Definition” dialog

Pull down “Map->Title” menu

Enter a title less than 32 characters in the Line 1 text field
Select “Top Center” in the Placement pull down menu

Cubtn Map Title{*)
Line 1 |SeaSonde Site TEST || _Font...
Line 2 SeaSonde Measurements Fant...
Flacement: Nao title *
X6 0.0000
y¥% (0.0000
Cancel | Draw. | oK

e Click “OK” to dismiss “Map Title” dialog
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Pull down “Map->Km Legend” menu

Check “Enable” box

Click “OK” to dismiss “Km Legend” dialog
Pull down “Map->Cm/s Legend...” menu
Check “Enable” box

Adjust “Placement” boxes as needed

Click “OK” to dismiss “Cm/s Legend...” dialog

000 Cmislegend(y
i Enabled

Placement

Scaling factor | 0.2500

% From left

¥ Fromtop  90.024

Units | emys s
Magnitude 40,000
Appearance | Text prop... |

| Cancel | | Draw | | OK |

Pull down “Map->N/S arrow...” menu
Check “Enable” box
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M 0O M MNorth Indicater(*)

i [“Jenabled
”%E % From left | 80.0000

% % Fromtop  20.000

Size factor 0.0000

Width factor 1/5 -
color | N 2lack N
Annotation Text prop...

Cancel | | Draw . oK

Click “OK” to dismiss “N/S arrow...” dialog
Pull down “Map->Date/Time...” menu
Check “Enable” box

0O O O Date/Time(*)

["Enabled
Placement

% From left | 30.000

% From top  |95.000

Appearance | Text prop...

| Cancel | | Draw | | OK |

e Click “OK” to dismiss “Date/Time” dialog
e  Pull down File->Save (use default Site File Options) and click OK button
e Hyphenate (or delete) any old map files in the SiteDefinitions folder

Note: The first SeaDisplay map file encountered in the SiteDefinitions folder having the name format
SiteMap_XXXX.smap will be opened automatically when SeaDisplay is launched.

You have now completed a basic map for displaying your radial data. Your completed map should look something like
this:
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EUEON MES Rebmary 33012 1052

13500 1I2%0 W
==

e  Once you have made a change to the default map, pull down File->Save (use default Site File Options)
e  Enter your four-character site code
e Click SAVE button

. Saveas..
Site Optional Chars
W | |

SiteMap_xxxx.smap will be written to /
Codar/SeaSonde {Configs /SiteDefinitions [

| Advanced... |

[ Canel [ save
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Declarations

Use of Equipment

Use of this equipment in a manner not specified by CODAR may cause an impairment of protections as

well as void any and all warranties.

FCC Supplier’s Declaration of Conformity
CODAR SeaSonde model # SSRS-100-4144

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Changes or modifications not expressly approved by CODAR could void the user's authority to operate the
equipment.

CODAR
1914 Plymouth Street, Mountain View, California 94043 USA
Phone: +1 (408) 773-8240
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